RAILROAD & CO.™

TrainController™
Bronze

Version 8

Users Guide

April 2016

Copyright© Freiwald Software 1995 - 2016
Contact: Freiwald Software
Kreuzberg 16 B
D-85658 Egmatting, Germany
e-mail: contact@freiwald.com
http://www.freiwald.com

All rights reserved.
The content of this manual is furnished for informational use only, it is subject to change without notice. The author assumes no responsibility or liability for any errors or inaccuracies that may appear in this book.
No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without the prior written permission of the author.
Table of Contents

About this Document ..................................................................................................... 7
   RAILROAD & CO. TrainController™ Users Guide ................................................. 7
   Help Menu ............................................................................................................. 8
   The Editions of TrainController™ ........................................................................... 8

Quick Start - Step 1: Installation and Program Start ............................................... 12
   Installation ............................................................................................................ 12
   Program Start ..................................................................................................... 13

Quick Start - Step 2: Controlling a Train .................................................................. 16
   Preparing a Train for Model Railroad Computer Control ................................... 16
   Controlling a Train ............................................................................................... 20

Quick Start - Step 3: Controlling Turnouts – The Switchboard .............................. 21
   Creating a small switchboard control panel ....................................................... 21
   Preparing a Turnout for Model Railroad Computer Control ............................. 23

Quick Start - Step 4: Creating Blocks - Tracking Train Positions .......................... 26
   Equipping the layout with feedback sensors ...................................................... 26
   Dividing the layout into Blocks ........................................................................ 27
   Entering the locations of Blocks into the Switchboard ...................................... 27
   Assigning Feedback Sensors to Blocks ............................................................. 29
   Displaying train positions on the Computer Screen ........................................ 32
   Simulating Train Movements on the Computer Screen .................................. 34

Quick Start - Step 5: Controlling Trains Automatically ........................................... 36
   Spontaneous Run ............................................................................................... 36
   Adjusting the Stop Location ............................................................................... 37
   Creating a Commuter Train ............................................................................... 41
   AutoTrain™ by Drag and Drop ......................................................................... 42
   Commuter Train with intermediate Stop ......................................................... 44

1 Introduction ............................................................................................................ 50
   1.1 Overview ....................................................................................................... 50
      Supported Digital and Control Systems ......................................................... 50
      Use .................................................................................................................. 51
      Components .................................................................................................. 52
      Automatic Operation ...................................................................................... 53
   1.2 Variants of Train Control ............................................................................... 54
      Spontaneous Runs ......................................................................................... 55
      AutoTrain™ by Drag & Drop ....................................................................... 55
      AutoTrain™ Symbol Bar .............................................................................. 56
      Schedule ........................................................................................................ 57
      Manual Train Control .................................................................................... 57
Comparison Chart ................................................................................................... 58

1.3 Fundamentals of Use ...................................................................................... 60
The Overall Principle .............................................................................................. 60
User Interface Design ............................................................................................. 60
Window Handling ................................................................................................... 61
Window Customization ........................................................................................... 63
Customization of Menus, Tool Bars and Keyboard Accelerators ......................... 64
File Handling ........................................................................................................ 64
Edit Mode ............................................................................................................... 64
Further Steps ......................................................................................................... 65
Switchboard .......................................................................................................... 65
Train Windows ....................................................................................................... 66
The Visual Dispatcher ........................................................................................... 67

2 The Switchboard ..................................................................................................... 69
2.1 Introduction .................................................................................................... 69
2.2 Size and Appearance ...................................................................................... 70
2.3 Drawing the Track Diagram .......................................................................... 73
2.4 Connecting the Turnouts ............................................................................... 73
2.5 Signals and Accessories .................................................................................. 76
   Signals ................................................................................................................ 77
   Accessories ........................................................................................................ 77
   Connecting Signals and Accessories ................................................................. 77
2.6 Text Labels ...................................................................................................... 77
2.7 Self-provided Switchboard Images .................................................................... 78
   Images ................................................................................................................. 78
2.8 Displaying Train Names and Symbols in the Switchboard ............................... 79

3 Train Control ........................................................................................................ 80
3.1 Introduction .................................................................................................... 80
   The Train Window ............................................................................................... 80
   Train List ............................................................................................................. 82
3.2 Engines ............................................................................................................. 83
3.3 The Throttle Control ...................................................................................... 85
3.4 Speedometer and Odometer ........................................................................... 87
3.5 The Simplified Speed Profile ........................................................................... 87
   Preparing the decoder ....................................................................................... 87
   The simplified Speed Profile ........................................................................... 88
3.6 Headlights, Steam and Whistle ......................................................................... 89
3.7 Passing control between Computer and Digital System ................................ 90

4 Contact Indicators ................................................................................................ 92
   Momentary Track Contacts vs. Occupancy Sensors ........................................ 92

5 The Visual Dispatcher I ........................................................................................... 96
RAILROAD & CO. is the leading product line of computer programs for digitally or conventionally controlled model railroads. It contains the following members:

- **TrainController™** is the world's leading software for model railroad computer control.
- **TrainProgrammer™** is the program, which makes programming of DCC decoders as simple as a few clicks with your mouse.
- **+Net™** is a module, that allows to control your layout with a network of several computers running **TrainController™**.
- **+4DSound™** is a module, that recreates realistic spatial sound effects for each model railroad layout controlled by **TrainController™** without the need to install onboard sound into each decoder.
- **+Street™** is a module for control of car systems with **TrainController™**.
- **+SmartHand™** is the world's premium handheld railroad control system designed for computer controlled model railroads.

**RAILROAD & CO. TrainController™ Users Guide**

An overview of the basic concepts of **TrainController™ Bronze** is provided in this Users Guide. By reading this document you can obtain information about the many features of the product. Additionally you are provided with the background information necessary for model railroad computer control with **TrainController™ Bronze**.

The document is divided into three parts. Part I provides a quick start tutorial for users, who are in a hurry and want to start quickly. Part II explains the fundamentals of use. Knowing the contents of this part you will be able to control your turnouts, signals, routes and trains manually and to perform basic automatic operation. Novice users should focus to this part first and put its content into practice before proceeding with Part III. Part III explains the extended features of the software for professional use of all features by advanced users.

Details of usage are mentioned only if they are necessary to understand the related issues or to point to important features of the program. If you want to know in detail, how specific functions are to be used, please refer to the **Help menu** of **TrainController™ Bronze**.
Some sections or paragraphs are highlighted with additional markings for novice or advanced readers or to indicate important notes. The markings and their meaning are:

- **B**
  Basic content. Novice readers should focus on these parts.

- **X**
  Extended content for advanced users. Novice readers should initially ignore these sections.

- **!**
  Important note.

**Help Menu**

The help menu installed with **TrainController™ Bronze** contains detailed reference information necessary for using the program. All menus, dialogs and options are completely described and can be referred to in the case of questions or problems.

Please note: the User Guide and the help menu are complementary and should be used together. If you want to know, what a certain term means or what a certain function does, please refer to the Users Guide. If you want to know, how a certain object is to be edited or how a specific function is to be executed, call the help menu.

- This User Guide is not a manual for everyday practical use!
- This User Guide should rather serve to describe the basics, technical terms and important relationships of **TrainController™ Bronze**.
- You should make it a habit to always consult the help menu during daily work. This is especially true for questions, how to do something, and in particular when problems arise. The full-text search usually leads quite quickly to the relevant information.
- Virtually every dialog box in **TrainController™ Bronze** is equipped with a help button. Before you change a setting in a dialog box for the first time, it should be natural for you to press the help button in this dialog box, in order to clarify what each currently displayed setting means.

**The Editions of TrainController™**

**TrainController™** is offered in three variants:
- **TrainController™ Bronze** provides a low-cost entry into computer controlled model railroads. It is primarily designed for users with small and medium size layouts and average requirements. Novice users, who do not know **TrainController™**, may consider doing their first steps with **TrainController™ Bronze**. The reduced functionality of this variant makes it easier to identify and to learn the basic functions of **TrainController™**.

- **TrainController™ Silver** is the successor of the established and well-known version **TrainController™ 5**. It is primarily designed for advanced users with upmarket requirements and owners of layouts of all sizes. While **TrainController™ 5** was already outstanding with regard to functionality, ease of use and quality, the improvements introduced in **TrainController™ Version 7** strengthen the leading position of **TrainController™ Silver** compared to the available competitors.

- **TrainController™ Gold** is the flagship of the **TrainController™** family and in a class of its own. **TrainController™ Gold** is primarily designed for users with supreme requirements, who want to operate their layout like the real professionals. While **TrainController™ Silver** is already able to operate even very large layouts, **TrainController™ Gold** provides much more convenience, efficiency and security for design and operation – especially for larger layouts.

This document provides an overview of the features of **TrainController™ Bronze**.
Part I

Quick Start
Quick Start - Step 1:
Installation and Program Start

You have obtained TrainController™ Bronze to control your model railroad with your computer. It is easily understood, if you are eager to control your layout with your computer as soon as possible. If you are in a hurry about starting without reading the complete Users Guide first, you can also reconstruct the following quick start tutorial about TrainController™ Bronze.

Detailed explanations about the fundamental concepts of TrainController™ Bronze can be found in Part II of this document. It is strongly recommended that you study the contents of Part II prior to working seriously with TrainController™ Bronze.

Now let us start:

Installation

The installation file of TrainController™ Bronze, its name is TCBSETUP.EXE, can be downloaded from the download area of the Internet home page of the software (www.freiwald.com) or started from a CD ROM.

After starting TCBSETUP.EXE a self-explaining window is displayed, that guides you through the steps, that are necessary to install TrainController™ Bronze on your computer.
Ensure, that you select the right language, because the selected language will also appear later, when running TrainController™ Bronze.

Before you start TrainController™ Bronze you should connect your digital system which you are using to control your model railroad, to the computer. Please refer to the instructions provided by the manufacturer of your digital system, to see how this is done.

Program Start

After correct installation of TrainController™ Bronze there should be an entry in the Start menu of your Windows system, which you can use to start the software.
Diagram 2: License Inquiry

When the program starts the software first asks for your license key. Do not be concerned, if you are not yet in possession of such key. Press **Continue in Demo Mode**, if you want to try the software before buying it.

If you are already in possession of a license, then enter the license key here or plug in the Railroad & Co. license stick into a free USB port of your computer and press **Continue**.

In the next step the connected digital system is configured. Usually the following screen appears automatically, when the program is started for the first time. If the program starts without displaying the screen shown below, then call the **Setup Digital Systems** command of the **Railroad** menu.
If your digital system and/or the serial or USB port of your computer, to which your digital system is connected, is not displayed correctly, press **Change** to select the right settings.

In order to test, whether the connection to the digital system is properly established, play around a little bit with the **Power Off** and **Power On** command of the **Railroad** menu. These commands stop or start your digital system, respectively. Your digital system should respond accordingly to these commands. If your digital system does not respond or if there are some error messages displayed, then do not proceed any further, until this problem is resolved. In case of problems in this area, check very thoroughly, that the digital system is properly connected to the computer according to the manufacturer’s instructions.

If the steps outlined above have been performed correctly, you are ready to take the first steps into model railroad computer control.
Quick Start - Step 2:
Controlling a Train

Preparing a Train for Model Railroad Computer Control

First put a train onto the tracks of your layout and run it with your digital system. This step is recommended to verify, that the digital system and the train are running correctly and also to bring the digital address of the train back to your mind. This is needed a few moments later.

Now ensure, that the Edit Mode option in the View menu is active.

![Diagram 4: View Menu](image)

In this mode it is possible to enter new data into the software or to change existing data. This is what we want to do next.

Call the New Train Window command of the Window menu. If this is done correctly, the following window will appear on your computer screen:
Diagram 5: Train Window

If you want to learn more about the various controls of this window, please refer to chapter 3, “Train Control”.

Now select the **Properties** of the **Edit** menu.

![Edit Menu and Properties Command](image)

Diagram 6: Edit Menu and Properties Command

This is one of the most important commands of **TrainController™ Bronze**. It is used for all objects contained in the software (trains, turnouts, signals, routes, etc.), whenever you want to change the settings of a particular object. The following window is displayed now:
Specify the same address, that you have been using previously to control the train with your digital system, in the field labeled **Address**. If you want to give your engine a name, that is more easy to remember, select the tab labeled **General** and enter an appropriate name. In the following we want to call this train “Passenger Train”.

You can see this name entered into the program in the image displayed below:
You may have noticed, that the term “train” is being used here, while the images show the term “engine”. If you want to read more about this difference, refer to section 3.2, “Engines”. In the following we will continue using the more general term “train”.

Now press **OK** to close the dialog and to commit these changes. We will now return to the main screen and are ready to control the train:
Controlling a Train

You may notice, that the color of some controls in the train window changed. This happened due to the fact, that we entered a digital address for our train. Now the software knows, how to control the train. To prove this move the mouse to the green control in the centre of the window. Click on it and drag the green control to the right. If everything has been done correctly so far, the train will slowly start to move. We have done the first successful step into model railroad computer control!

Before continuing I suggest that you enjoy playing with the train. Play around with the green control, which is actually an on-screen throttle. Drag it to the right and back to zero, then to the left and watch, how your train responds to these actions. See, how the speedometer needle above of the throttle indicates the scale speed of your running train. Watch the odometer increasing. By clicking the green arrow you will reverse the direction of your train.

There are many more things, that TrainController™ Bronze can do for realistic control of your trains. You can operate auxiliary functions (light, whistle, coupler, etc.), adjust the momentum to your personal needs and scale the speed and distance measurements to the physical characteristics of your train. This is discussed in detail in chapter 3, “Train Control”.
Quick Start - Step 3:  
Controlling Turnouts – The Switchboard

Creating a small switchboard control panel

So far the area in the background of the main window of TrainController™ Bronze is still empty. It contains a number of cells, that are arranged in rows and columns. These cells are still empty. We want to fill this empty area with a small switchboard control panel for the following small track layout:

![Diagram 10: Small Sample Layout](image)

In the first step we will draw the track diagram in the switchboard window. First ensure that Edit Mode in the View menu is still turned on (see Diagram 4). Next select the Draw tool in the Tools menu.
Now move the mouse to the cell in the switchboard window, where the left end of our track diagram will be located. Click and hold the left mouse button and drag the mouse about 25 cells to the right. Then release the left mouse button. The following image should now be visible in the switchboard window:

We have drawn a straight track section. Now move the mouse to a cell on this track section, that is located about one third to the right of the left end. Click the left mouse button and drag the mouse one cell to the right and one cell up. Then release the left mouse button. Now you should see something similar to the following:
Diagram 13: Track section with turnout

The first turnout in the switchboard has now been created. Now click on the cell, where the diverging route of this turnout ends and drag the mouse to the right to a cell, that is located about one third left of the right end of the straight track section.

Diagram 14: Extending the track diagram

Finally click on the cell, where the last mouse movement ended, and drag the mouse one cell to the right and one cell down.

Diagram 15: The complete track diagram

The track diagram of our small sample layout is now complete and should look like Diagram 15.

If you want to operate real turnouts of your existing model railroad with the track diagram control panel just created, try to identify a small area of your layout, that contains a similar track structure with two turnouts as shown above. Now operate these turnouts with your digital system. This step is recommended to verify, that the digital system and the turnouts are correctly working and to bring the digital addresses of the turnouts back to your mind. This is needed in the next step.

Preparing a Turnout for Model Railroad Computer Control

Ensure, that the **Edit Mode** option in the **View** menu is still active (see Diagram 4).
Now click on the symbol of the left turnout in the track diagram and select the **Properties** of the **Edit** menu. Do you remember? This command is used for all objects contained in the software (trains, turnouts, signals, routes, etc.), whenever it is required to change the settings of the particular object. The following window is now displayed:

![Diagram 16: Specifying the Digital Address](image)

Specify the same address, that you have been using previously to control the corresponding real turnout with your digital system, in the field labeled **Address**. Now click on the symbol of the turnout, that is located to the right of the label **Test**. The real turnout on your model railroad layout should now respond. Depending on the wiring of your turnout it is possible, that the image in the software and the physical turnout do not show the same status (closed vs. thrown). If this is the case click on the grey circle in the upper row of the **Output Configuration** to adjust the displayed status (see Diagram 16). The highlighting in the **Output Configuration** should now change and the displayed image
of the turnout and the status of the turnout should be in sync, when you test the turnout again. Note, that the layout of this area may vary with the connected digital system.

Some advanced background information: in many cases, dependent on the digital system used, the highlighting in the Output Configuration will reflect the keys, that are to be pressed on the handheld of your digital system to set the turnout (or any other accessory, that is operated by turnout commands) to the corresponding state. Whenever the display of the turnout on the computer screen and the status of the turnout on your layout are not in sync, then you should operate the turnout first with your handheld and remember the keystrokes used to achieve a certain state. You should then translate these keystrokes to the Output Configuration of this turnout.

If you want to give your turnout a name, that is easier to remember, select the tab labeled General and enter an appropriate name.

Now press OK to close the dialog and to commit these changes. We will now return to the main screen and are ready to control the turnout. To do this, turn off Edit Mode in the View menu (see Diagram 4), move the mouse to the symbol of the turnout in the track diagram of the switchboard window, click on this symbol and watch, how the real turnout on your layout responds.

Finally perform the same for the right turnout symbol in the track diagram.

We are now able to control a train and a small layout manually with the computer. I suggest that you run the train back and forth on this small layout a little bit and play with different routes by changing the positions of each turnout prior to each run of the train.

In the next step we will learn, how trains can be operated automatically under control of the computer.
Quick Start - Step 4:
Creating Blocks - Tracking Train Positions

Equipping the layout with feedback sensors

The most important prerequisite for controlling trains automatically with your computer or to monitor the movements of trains on the computer screen is equipping the layout with feedback sensors. These sensors are used to report train movements back to the computer. Based on this information **TrainController™ Bronze** is able to take the right decisions to direct automatically running trains to their destination or to monitor the movement of trains.

Two types of feedback sensors can be used: occupancy sensors and momentary track contacts. Details of this difference and more detailed information about feedback sensors can be found in chapter 4, “Contact Indicators”.

In the following we assume, that occupancy sensors are used to control our small layout and that our layout is divided into four detection sections according to the following image:

![Diagram 17: Detection Sections and Occupancy Sensors](image)

There are other ways to divide a layout into detection sections or to control it with momentary track contacts. Further, the scheme displayed above is also **not necessarily the optimal solution**. The above scheme has been chosen for this tutorial for reasons of simplicity and because it is sufficient to perform a quick start. Other variants for equipping your layout with feedback sensors are outlined in more detail in section 5.8.
Dividing the layout into Blocks

Another important prerequisite for controlling trains automatically with your computer or to monitor the movements of running trains is separating the layout into logical blocks. Blocks are the base elements for automatic train control and tracking of train positions. There is a close relation between feedback sensors and blocks: each block is associated with one or more feedback sensors.

There are certain guidelines for creation of blocks. They are outlined in detail in section 5.2, “Blocks”. According to these guidelines we divide our small sample layout into blocks as shown below:

As you can see we have applied a 1:1 relation between blocks and detection sections here. Please note, that this is not always the case. In many cases more than one detection section or feedback sensor will be associated with one block. However, it is also possible to control your layout or appropriate parts of it with one feedback sensor per block. For reasons of simplicity and because it is sufficient for the quick start we go with one detection section per block here, too. Please keep in mind, however, that blocks and detection sections are not the same thing.

More details about this topic are outlined in detail in section 5.6, “Blocks and Indicators”.

Entering the locations of Blocks into the Switchboard

Blocks are represented by TrainController™ Bronze on the computer screen by rectangular symbols. To enter the blocks, that are needed to control our train on our sample layout, turn on Edit Mode in the View menu and select the Block command of the Tools menu.
Now click on the cell, that is located right of the cell, that contains the left end of our track diagram. A block will appear at this location.

Please do the same for the three other blocks. Note, that the cell, where you click, determines the leftmost end of the block. Ensure also, that you click on a cell, that contains a piece of straight track.

You can change the size of each block by dragging its left or right border.

If everything was done correctly, the track diagram should look like the following image:
Assigning Feedback Sensors to Blocks

There is a close relation between feedback sensors and blocks: each block is associated with one or more feedback sensors. To assign a feedback sensor to a block, select “Block 1” in the switchboard track diagram and call the Properties command of the Edit menu.

Then select the Block Editor tab in the opened dialog box.
It shows the properties of the block and indicates, that no sensor is yet assigned to this block.

Click on \[\text{\textbullet}\] in the tool bar of the block editor. This is the item, which is highlighted in Diagram 22. The block editor now changes as follows:

![Diagram 23: Block Editor with Contact Indicator](image)

The center of the block editor now shows a reddish rectangle. This rectangle is called contact indicator and represents the occupancy section within the block, which is monitored by the feedback sensor.

Now click on the contact indicator (i.e. the reddish rectangle) and then click on the **Properties** command in the tool bar of the block editor. This is the highlighted symbol in Diagram 23. The dialog box displayed below is opened:
Diagram 24: Specifying the Digital Address of a Contact Indicator

Now specify the digital address of the feedback sensor, that belongs to this contact indicator. In most cases this is the digital address of the feedback decoder and the number of the contact input of this decoder, to which the sensor is connected.

To test your settings, put a train or anything else, that is suited to trigger a feedback event, into the detection section, that corresponds to “Block 1”. The block in the track diagram in the switchboard should now change its color to red:

Diagram 25: Indication of an occupied Block

Now create and assign contact indicators to the other three blocks, too.
If this has been done correctly, the blocks in the switchboard will change their color according to the movements of your train on the layout. Play around a little bit with your train and watch how the blocks in the switchboard are indicated.

**Displaying train positions on the Computer Screen**

Now we are ready for *train tracking*, i.e. displaying of train positions on the computer screen.

To do this move your real train into “Block 1”, if it is not located there already. Ensure, that the train is heading towards the other blocks, i.e. that it has to run forward, in order to go to “Block 2” or “Block 3”, respectively.

Then turn off **Edit Mode** in the **View** menu (see Diagram 4). Next select “Block 1” in the switchboard and call the **Assign Train** command of the **Block** menu according the following image:

![Diagram 26: Block Menu](image)

In the following dialog select the “Passenger Train” and select the train orientation by marking the option near the arrow pointing to the right.
Diagram 27: Assigning a Train to a Block

After pressing **OK** the symbol of the train will appear in “Block 1” in the switchboard control panel:

Diagram 28: Display of Train Positions on the Computer Screen

Instead of using the **Assign Train** command you can also drag and drop the train symbol with the mouse from another place on the computer screen to “Block 1”, if the train symbol is visible somewhere else.

Now run the train with the on-screen throttle of the train window displayed in Diagram 9. When the train travels to another block, the display should be updated accordingly and the symbol of the train should move to the symbol of the other block. If you are test-
Simulating Train Movements on the Computer Screen

If no layout is connected, you can also simulate the described movements on the computer screen. For this purpose call the Simulator command of the Windows menu.

This opens the Simulator window as displayed below:

Start the simulator by clicking on the leftmost symbol in the toolbar of the simulator window. This is the highlighted item in Diagram 30.

If you now start the train with the train window in the forward direction, i.e. by dragging the green on-screen throttle in the train window to the right, you will notice, that the symbol of the train moves from block to block on the computer screen. You can even
change the turnout positions and watch, how the movement of the train symbol follows accordingly.

If all steps are performed correctly so far, then you are able to control the movement of your train and operate your turnouts with TrainController™ Bronze. You are also able to track the positions of moving trains on the computer screen.
Quick Start - Step 5: 
Controlling Trains Automatically

Spontaneous Run

The last part of our quick start tutorial is automatic control of running trains. In the first step a train located in “Block 1” of our small sample layout will run to “Block 4” and stop there. To do this run our train manually back to “Block 1”. Train tracking should ensure, that the display reflects this movement and finally looks like Diagram 28. Please ensure that Edit Mode in the View menu is turned off (see Diagram 4).

Now select “Block 1”, i.e. the block, where the train image is located, and call the Spontaneous Run to the Right command of the Train menu.

The display in the switchboard should now change and show something similar to the following:
Simultaneously the real train on your layout should start to move now and run through “Block 2” or “Block 3” to “Block 4”, where it should slow down and stop.

The same maneuver can be simulated without a connected model railroad layout by turning on the Simulator (see page 34).

**Adjusting the Stop Location**

You may have noticed, that the train stopped as soon as the occupancy sensor in “Block 4” was turned on. In order to adjust the location, where the train stops in “Block 4”, turn on **Edit Mode** via the **View Menu** (see Diagram 4), select “Block 4” and call the **Properties** command of the **Edit** menu.

Then select the **Block Editor** tab as displayed below.
Click on the red rectangle (contact indicator) in the center of the block editor and then on the **Insert Brake Marker Right** command in the tool bar of the block editor (see Diagram 33). Two triangle symbols will now appear in the work area of the block editor.

The block editor should look like the following image now:
The yellow triangle marks the point, where the train will begin to slow down in “Block 4”. The red triangle marks the point, where the train will stop. We assume, that the train will stop in a certain distance away from the left border of the occupancy section. Click on the yellow triangle, and drag the slider near the label **Ramp** to the center position.

The block editor should now look like the following image:
Now press **OK** and repeat the procedure outlined in the section “Spontaneous Run”. The train should now begin to slow down, when it arrives at the occupancy section in “Block 4” and stop somewhere inside of “Block 4”.

If the train does not stop at the desired location in “Block 4”, then adjust the ramp setting accordingly as described above. More information can be also found in section 5.6, “Blocks and Indicators”.

During later practice, when everything is configured completely, we expect a train to stop at more exact positions in a block. However, this requires installation of an additional sensor at the point, where trains will stop, (see also section 5.8, “Arranging Indicators and Markers in a Block”) or calibration of locomotive settings (described in section 3.5, “The Simplified Speed Profile”). As far as this tutorial is concerned we are satisfied, if we can get the train to slow down and to stop smoothly somewhere within a block.

Now add a red and a yellow triangle, which point to the left, to “Block 4” in the same way described above and specify a similar setting for the **Ramp**.
Finally do the same for all other blocks “Block 1, “Block 2” and “Block 3”.

Creating a Commuter Train

In the next step we want a train located in “Block 1” of our small sample layout to run back and forth between “Block 1” and “Block 4”. To do this run your train manually back to “Block 1”. Train tracking should ensure, that the display reflects this movement and finally looks like Diagram 28. Ensure that Edit Mode in the View menu is turned off (see Diagram 4).

Now select “Block 1”, i.e. the block, where the train image is located, and call the Rules command of the Train menu.

Diagram 36: Rules Command

Then check the option Reverse automatically:
Diagram 37: Rules for Spontaneous Runs

This will cause the train to reverse in “Block 4”, because this is a dead end in our small layout, and travel back to “Block 1”. Back in “Block 1” it will reverse again and run back to “Block 4” and so on.

Press OK, select “Block 1”, i.e. the block, where the train image is located, call the Spontaneous Run to the Right command of the Train menu and watch, how this works.

This can also be simulated without a connected model railroad layout by turning on the Simulator (see page 34).

AutoTrain™ by Drag and Drop

In the next step we want the train to start in “Block 1” and stop in “Block 3”. This cannot be accomplished with spontaneous runs as outlined above, because in a spontaneous run the train may select another path, i.e. “Block 2”, for its travel. Furthermore, it will not stop until it reaches a dead end (here “Block 4”).
To do this run our train manually back to “Block 1”. Train tracking should ensure, that the display reflects this movement and finally looks like Diagram 28. Ensure that **Edit Mode** in the **View** menu is turned off (see Diagram 4).

Now select the **AutoTrain by Drag and Drop** command of the **Schedule** menu.

![Diagram 38: AutoTrain by Drag and Drop](image)

Then move the mouse pointer to the train symbol located in “Block 1”. The mouse cursor should now show an ‘A’ and an arrow pointing to the right:

![Diagram 39: Running a train automatically with AutoTrain™](image)

Click on the train symbol and drag the mouse to “Block 2”, to be precise into the right half of “Block 2”, until the mouse pointer shows the same sign displayed above. Now release the left mouse button. The display in the switchboard should now change and show something similar to the following:

Simultaneously the real train on your layout should start to move and run from “Block 1” to “Block 3”, where it should slow down and stop.
After the train has stopped, you can let it run back to “Block 1” automatically by calling the **AutoTrain by Drag and Drop** command once more and dragging the train symbol back to “Block 1”. Please ensure, that the mouse pointer now points to the left before clicking on the train symbol and before releasing the left mouse button, since the train should now run to the opposite direction.

**Commuter Train with intermediate Stop**

As a final step of our tutorial we want to run the train automatically back and forth between “Block 1” and “Block 4” several times. The train will always select the right block with regard to direction of travel, i.e. when running to the right, the train will pass “Block 3”, when running to the left the train will pass “Block 2”. Additionally the train will perform a short intermediate stop in “Block 2” and “Block 3”, respectively, during each pass.

This cannot be accomplished with AutoTrain by Drag and Drop, because this does not allow us to specify intermediate stops.

To do this, run the train manually back to “Block 1”. Train tracking should ensure, that the display reflects this movement and finally looks like Diagram 28. Ensure that **Edit Mode** in the **View** menu is turned off (see Diagram 4).

![Diagram 40: Locking the left Entry of a Block](image)

Now select “Block 2” and call the **Lock Entry (left)** command of the **Block** menu. This ensures, that the train will not pass through “Block 2” on its way to “Block 4”. Then select “Block 3” and call the **Lock Entry (right)** command of the **Block** menu.
The switchboard should now look as follows:

Diagram 41: Locked Block Entries

Next select “Block 1” and call the AutoTrain command of the Schedule menu. This opens the AutoTrain™ tool bar as displayed below:

Diagram 42: Schedule Menu

Diagram 43: AutoTrain™ Tool Bar
Ensure that a green marking appears at the right hand side of “Block 1”. This indicates, that we want to start our train in this block and to travel to the right. If this marking is not set, select “Block 1” and press 

Next select “Block 4” and press . This indicates, that the train will enter “Block 4” from the left to the right and stop here. Now press . The software now checks, whether there is a path from “Block 1” to “Block 4”. As a result “Block 2” and “Block 3” are displayed on the screen with the same intensity as “Block 1” and “Block 4”. This indicates, that there is a path from “Block 1” to “Block 4”, that passes “Block 2” or “Block 3”, respectively.

Now press . TrainController™ Bronze opens the following dialog:

![Diagram 44: Specifying a Shuttle Train](image)

Here select Shuttle as Type and 10 as Repeat Count. This tells the software, that you want to create a train, that will run back and forth (shuttle) ten times. You can specify any number as Repeat Count. Commit your settings with OK.
Now select “Block 2” and press \[ \text{TrainController}^\text{TM \ Bronze} \]. The software opens the following dialog:

![Diagram 45: Specifying a Waiting Time](image)

Enter **00:02:00** in the box below **Waiting Time**. This tells the software, that the train is to wait 2 simulated minutes in “Block 2”. The duration of simulated minutes is scaled with an internal hard-coded scaling factor. Commit your settings with **OK**. Perform the same steps for “Block 3” to specify a waiting time for “Block 3”.

Now press \[ \text{A} \]. The train will now start to move towards “Block 3”. In “Block 3” it slows down and stops for a while. Then it starts again and enters “Block 4”. Here it slows down again, stops and starts in the opposite direction. In “Block 2” it slows down and stops again. After a while it starts again and runs to “Block 1”, where it stops. Then the complete cycle is repeated again.

You are now able to configure control of automatically running trains. Beginning with spontaneous runs you can easily run a train automatically without further measures. AutoTrain by Drag & Drop provides more control over, where trains will go. The
AutoTrain Symbol bar, that we used in the last step, provides full control of the train during it’s automatic run.

However, TrainController™ Bronze is able to perform much more complex train control on much more complicated track layouts. To learn, how these amazing things can be done with TrainController™ Bronze continue reading part II of this Users Guide.
Part II

Fundamentals
1 Introduction

1.1 Overview

TrainController™ Bronze is a system which enables you to operate a model railroad layout from a Personal Computer running Microsoft Windows 8.x, Windows 7, Vista or XP.

TrainController™ Bronze provides you with the ease of point and click operation of your turnouts, signals, routes and other accessories displayed on a track diagram panel. You can run your trains with on-screen throttles, external hand held throttles connected to your computer, or with your favorite throttles or hand held throttles supported by your digital system. Far-reaching automation features make railroad operations manageable by one person and match those found on the largest club layouts. You can see on the screen which engine/train is on which track.

Supported Digital and Control Systems

The software supports all major digital and control systems which provide a computer interface. Among others the following systems are supported (list is not exhaustive):

- Digitrax LocoNet
- Lenz Digital Plus
- North Coast Engineering Master Series (NCE)
- Roco-Digital
- Maerklin Central Station 1 and Central Station 2
- Maerklin Digital
- ESU ECoS
- CTI
- RCI
- Trix Selectrix
- Müt Digirail
- Rautenhaus Digital
- Uhlenbrock Intellibox, Intellibox 2, Intellibox Basic and IB-COM
- Tams Master Control
- Fleischmann Twin Center
- Fleischmann Profi-Boss
• Littfinski HSI-88
• Zimo
• Doehler & Haas / MTTM Future Central Control
• and others

For the complete list refer to the Help menu of TrainController™ Bronze.

You can run up to two systems simultaneously on different serial or USB ports. If your favorite digital system is not able to report the state of feedback sensors, then you are able to enlarge this system with a second system that is able to do this. Note that this second system can be used in TrainController™ Bronze only for monitoring of feedback sensors. The control of all turnouts and locomotives must be done via the first digital system.

TrainController™ Bronze also supports an offline mode that allows trial operation without a connection to a real model railroad. If the END key of your keyboard is pressed and held at the start of a session or when a file is being loaded, then the session will start in offline mode. This is useful for testing purposes or if the most recently used digital systems are currently off or not connected. All the settings of the digital systems (e.g. COM port numbers) remain unchanged for later online operation.

For each digital system additional information is provided that further explains the use of the particular system with TrainController™ Bronze. This information can be found by opening the help menu of TrainController™ Bronze and entering the name of the digital system or the name of the manufacturer as search key.

Use

TrainController™ Bronze is easy to use. It provides an easily learned, intuitive, graphical user interface that is developed according to the following guidelines:
• Use of **TrainController™ Bronze** is possible without the need to be a computer expert or programmer.
• Graphical items are provided instead of an abstract command syntax.
• Operation is based on natural objects like trains, turnouts, signals, etc. instead of digital addresses or something else.
• Activities are natural - point to a signal and set it to red with a simple mouse click instead of issuing a command like “set contact output of decoder 35 to 1”. Accelerate a train to speed 35 mph instead of typing “set speed level of train decoder 16 to 7”.
• Automatic Operation can be arranged within minutes without the need to learn a programming language first.

**Components**

Each component of **TrainController™ Bronze** has its own special functionality and most of them can be used separately. You only need to concentrate on the components you choose to use. The control of trains and the operation of turnouts and signals is separated.

These are the components of **TrainController™ Bronze**:

• **The Switchboard**: easy to use control panel editor for the operation of turnouts, signals and other accessories with point and click ease. It allows manual and fully automatic operation of your layout.
• **The Train Window**: on-screen throttles and various cab instruments for realistic train operation
• **The Dispatcher**: intelligent monitoring and operation of your entire model railroad, or just parts, that can be arranged within minutes
Automatic Operation

Because you want to control your model railroad with your computer, you are probably interested in operating parts (or all) of your layout automatically. **TrainController™ Bronze** does not require you to be an experienced programmer or computer expert in order to do this. For this reason, **TrainController™ Bronze** does not require you to learn a special railroad programming language with a new syntax. Automatic operation can be accomplished by a simple point and click on the objects which are to be operated.
or monitored. No abstract syntax must be learned. Configuration of automatic operation is as easy as drawing a track diagram.

The number, range and complexity of activities that can be managed by one person is extended substantially. A broad range of operating flexibility is provided that extends from a completely manual operation through to a completely automatic operation (e.g. hidden yards control). Manual and automatic operations can be mixed simultaneously. This applies not only to trains on different areas of your railroad, but also to different trains on the same track, and even to the operation of a single train. The automatic processes are not bound to specific trains. Once specified, they can be performed by each of your trains. Randomizer functions increase the diversity of your model railroad traffic.

### 1.2 Variants of Train Control

Train control, i.e. running of model trains on a model railroad layout, is the key aspect of model railroading and hence also for TrainController™ Bronze.

TrainController™ Bronze provides a wide range of possibilities to run your trains – from completely manual to completely automatic with a wide range of variants.

The following list provides a brief overview of the different methods to run your trains with TrainController™ Bronze:

1. Run trains manually, semi-automatically or automatically under full protection, blocking and routing of TrainController™ Bronze along paths and routes, which are automatically activated by the train itself or manually by the end user during the train run. Trains are started ad-hoc, i.e. without specifying destination positions or complete paths in advance (Spontaneous Run).
2. Run trains manually, semi-automatically or automatically under full protection, blocking and routing of TrainController™ Bronze by specifying the start and destination positions at any time during operation by dragging a train symbol with the mouse from its current position to the desired destination position (AutoTrain™ by Drag & Drop).
3. Run trains as before, but specify more than one start and destination position as well as other options such as scheduled waiting times, speed limits etc. at any time during operation just before starting the train (AutoTrain™ Symbol Bar).
4. Run trains manually, semi-automatically or automatically under full protection, blocking and routing of TrainController™ Bronze according to schedules, i.e. sets of options, which specify several start and destination positions as well as other options such as scheduled waiting times, speed limits etc. and which are created
prior to the operating session, i.e. during configuration of the layout. Schedules can be started manually or as part of a sequential chain (Schedules).

(5) Run trains manually without any protection, blocking and routing performed by TrainController™ Bronze (Manual Train Control).

**Spontaneous Runs**

This is the most handy method to run your trains under full protection and routing of TrainController™ Bronze. Just put a locomotive on the track and call the menu command Spontaneous Run. The train will immediately start to move, provided that the route ahead is clear. It will then select an appropriate path and continue to travel, until it reaches a dead end or until the path ahead is blocked for another reason. At a dead end it will reverse automatically, if desired, and continue to travel to the opposite direction.

Routes can be treated in different manners for spontaneous runs. It is either possible to allow the computer to select and activate all routes requested by the train automatically. It is also possible to leave this to the human operator. In this case the train is stopped in blocks with at least one outgoing route, until one of these outgoing routes is selected and activated by the human operator.

**Pros:**
- Well suited to accomplish hands-on activity on your model railroad layout including protection, routing and signaling with minimum efforts.
- Easiest way to run trains under full protection and routing.
- Can be spontaneously executed at any time during operation.
- Fastest way to start a train with a +SmartHand™ handheld under protection of the software.

**Cons:**
- In general human intervention or specific measures are required to prevent trains from running into tracks, where they must not go.
- Not suited for full automatic operation of the layout, without further measures, because in general human intervention is required to start the train.

**AutoTrain™ by Drag & Drop**

This is another very convenient method to run trains under full protection and routing of TrainController™ Bronze. Just put a locomotive on the track and drag the symbol of the train on the computer screen with the mouse from its current position to the desired destination position. The train will immediately start to move, provided that the route
ahead is clear. It will then select an appropriate path to the specified destination block and travel there, if possible. After arrival at the destination block the train is stopped.

**Pros:**
- Well suited to move a train spontaneously to a certain location of the layout under full control of the software, protection, routing and signaling, with minimum effort.
- Very easy way to run trains under full protection and routing.
- Can be spontaneously executed at any time during operation.
- Full control of the destination block, where the train will go.

**Cons:**
- Care has to be taken, that there is a possible path between the current position of the train and the desired destination block.
- Not suited for full automatic operation of the layout, because human intervention is required to start the train.

**AutoTrain™ Symbol Bar**

This is an extension of **AutoTrain™ Drag & Drop**. Instead of dragging a train symbol from its current position to the desired destination the path of the train and other options are specified via the **AutoTrain™ Symbol Bar**. This symbol bar provides more options than the more simple drag & drop method. The full functionality for automatic running of a train is available here. Among other options it is possible to specify more than one start and destination block, to enforce inclusion or exclusion of certain blocks, to specify scheduled waiting times during the travel, to determine, whether the train will be controlled manually, automatically or by a mixture of both, and so on. The **AutoTrain™ Symbol Bar** is also used to predefined train runs (schedules) for automatic operation of the layout.

**Pros:**
- Well suited to move a train spontaneously to a certain location of the layout with the possibility to apply the full range of options available for train control.
- Used, too, to predefine train runs (schedules) for full automatic operation with minimum effort.
- Provides the full range of options available for trains running under protection and routing.
- Can be spontaneously executed at any time during operation.
- Full control of the path taken by the train.

**Cons:**
• Care has to be taken, that there is a possible path between the specified start and destination blocks.
• Not suited for full automatic operation of the layout without further measures, because human intervention is required to start the train.

**Schedule**

Schedules provide the possibility to predefine train runs in advance and in particular for full automatic operation. Unlike the other methods schedules do not require manual intervention to be started. The full functionality for automatic running of trains is available for schedules, too. Among other options it is possible to specify more than one start and destination block, to predetermine the exact paths, to specify scheduled waiting times during the travel, to determine, whether the train will be controlled manually, automatically or by a mixture of both, and so on.

**Pros:**
• Well suited for full automatic operation of trains without human intervention.
• Provides the full range of options available for trains running under protection and routing.
• Can be started automatically without human intervention.
• Full control of the path taken by the train.

**Cons:**
• Require predefinition prior to operation of the layout.

**Manual Train Control**

Manual train control is performed by putting a train on the track and by driving it with the throttle of the digital system, with the on-screen throttle of TrainController™ Bronze or with a +SmartHand™ handheld without taking any further measures. Although the position of the train can be tracked by the computer, the computer does not activate routes ahead of the train or take corrective action like stopping the train at a red signal. The human operator is completely responsible for routing and stopping. A train driven in this way, however, is protected against other trains running under control of the computer, while other trains are not automatically protected against this train, i.e. the human operator is responsible for ensuring, that the train operated by him in this way does not run into other trains.
Pros:
- Well suited for manual test runs and basic operation without protection, routing or signaling.
- Can be spontaneously executed at any time during operation.

Cons:
- Low security.
- No automatic routing or signaling.
- Manual control of trains only.
- Number of trains simultaneously operated this way is limited by the skills of the human operator to control and to watch several trains at the same time (usually 1 to 3 per operator).

Comparison Chart

The following chart compares the possibilities of the particular methods and their suitability for certain purposes:
<table>
<thead>
<tr>
<th>Feature</th>
<th>(1) Spontaneous Run</th>
<th>(2) AutoTrain™ Drag &amp; Drop</th>
<th>(3) AutoTrain™ Symbol Bar</th>
<th>(4) Schedules</th>
<th>(5) Manual Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block Securing</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Automatic Routing</td>
<td>Optional</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Automatic Signaling</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Train Guidance System</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Automatic Consideration of Speed Limitations</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Full functionality for automatic train operation available (e.g. Scheduled Stopovers,…)</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>No. of possible Start Blocks per Run</td>
<td>1</td>
<td>1</td>
<td>&gt;=1</td>
<td>&gt;=1</td>
<td>-</td>
</tr>
<tr>
<td>No. of possible Destination Blocks per Run</td>
<td>&gt;=1</td>
<td>1</td>
<td>&gt;=1</td>
<td>&gt;=1</td>
<td>-</td>
</tr>
<tr>
<td>Start without prior specification of destination Blocks</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Preset for destination possible</td>
<td>Indirect</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Spontaneous execution w/o prior predefinition</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Manual Train Control possible</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Transfer of Control between operator and computer according to curr. signal status poss.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Automatic Train Control poss.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Effort for Setup/Start</td>
<td>Minimal</td>
<td>Minimal</td>
<td>Medium</td>
<td>Medium</td>
<td>Minimal</td>
</tr>
<tr>
<td>Automatic Layout Operation without human intervention</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Table 1: Variants of Train Control

All the methods listed above can be used simultaneously and freely combined. The following modes to run trains manually, namely:

- Run trains manually with the throttle of your digital system.
- Run trains manually with the virtual on-screen throttle of **TrainController™ Bronze**.
• Run trains manually and fully protected with the physical throttles of the +SmartHand™ handheld control system

can be applied to any manually or semi-automatic operated train for any of the methods listed before. It is also possible to pass each train from manual operation to any of the automatic modes listed before and back or between the particular modes listed above at any time during operation. In short terms: there are almost no limitations.

1.3 Fundamentals of Use

The Overall Principle

TrainController™ Bronze supports manual, semi-automatic and automatic operation of your model railroad as well as concurrent manual and automatic operation.

The Switchboard and Train Windows provide the controls to operate turnouts, signals, routes and trains, etc. These controls can be operated manually by the human operator or automatically by the computer.

A human operator is normally only able to operate the switchboard and at most two trains at the same time. If multiple trains are to be operated at the same time, then either support of additional human operators is required, or a computer running TrainController™ Bronze. The software contains a special component called the Visual Dispatcher, which is able to take the place of additional human operators.

Like a human operator the Visual Dispatcher is able to operate turnouts, signals, routes and trains. This is called automatic operation.

Manual and automatic operation can be mixed like several human operators can cooperate to control the same layout.

You can also decide to do without the Visual Dispatcher, if you want to control everything yourself.

User Interface Design

The user interface of TrainController™ Bronze can be extensively customized to your personal needs and taste.
This begins with the overall layout of the user interface. The user interface can be displayed by applying different visual styles. Among others the following styles are available:

- Several Office 2010 and 2007 styles
- Visual Studio 1010, 2008 and 2005
- Native XP
- Office 2003
- Classic Office 2000

Feel free to select the style, that fits best your personal taste.

**Window Handling**

The particular functions of **TrainController™ Bronze** are represented in different windows. Normally you will open several windows for the same model railroad layout. If you want to control different trains with different train windows then you can open additional windows for the same layout.

Additional windows (train windows, etc.) are opened and closed through the **Window** menu of the software. Each window can be made invisible at any time without loss of data.

Diagram 46 shows an open layout file that contains several windows. The file contains among others, a switchboard window, a train window and a Dispatcher window for automatic operation.

The general visual design of all windows is harmonized and the handling of all windows is consistent. The size of all windows is variable and can be adjusted to your personal taste.
Each window can appear in one of the following states:

- Docked to one of the borders of the main window.
- Docked to another window.
- Floating at any location on the computer screen; individually or grouped/docked together with other windows.
- Tabbed with other windows – as one of several tabbed documents in the background of the main window or together with other windows in a floating or docked frame.
- Auto-Hidden while not active with quick access via a button on any side of the main window.

The possibility to group related windows together in **TrainController™ Bronze**, either docked or tabbed, in the main window or in a floating frame somewhere on the computer screen, opens interesting possibilities. It is possible, for example, to arrange a set of related windows for control of one part of the layout together in one group and to arrange another set of related windows for another part of the layout in another group. Such group of related windows can be then moved, resized, hidden, restored and even docked and tabbed together with other groups of windows just like one single window, which makes it very convenient and effective to manage sets of windows, that belong together. An example of such related windows is a switchboard combined with a dispatcher window, that shows just the block diagram of this switchboard. No matter how many windows you need to open to represent your entire layout, you will find a window arrangement, that fits your needs and personal taste.

**TrainController™ Bronze** makes docking of windows intuitive and easy by showing docking markers for each window, that is currently being dragged over the computer screen. The docking markers intuitively indicate, where to move the mouse to dock the dragged window to the desired location. By moving the mouse to a docking marker an additional docking outline provides a clear preview of the docking effect. Thanks to this feature, which has been borrowed from state-of-the-art professional software development systems there is no more puzzling, where a window will be finally docked.
Diagram 47: Docking a Train Window to the right of a Traffic Control

**TrainController™ Bronze** stores the window arrangement individually for each project. Especially those users, who work with different data files for different projects will appreciate the possibility to create and to save an individual arrangement of windows for each particular project.

Even for the rare case, that the windows on your computer screen are misaligned and you don’t know how to return to a consistent state, provisions have been made: with a specific menu command it is possible to load the current data file once more with a default window status, which can be used again as a starting point for an individual arrangement.

**Window Customization**

The layout of those windows, which contain the most comprehensive data or which are used most frequently (the switchboard, dispatcher and train window) can be highly customized to personal needs and taste.

You can play with all settings without any risk, because in **TrainController™ Bronze** all customizable windows provide the possibility to reset the settings to factory defaults.
Customization of Menus, Tool Bars and Keyboard Accelerators

It is also possible to customize the content of menus and tool bars and to change keyboard accelerators.

New menus and tool bars can be created, commands can be added or removed from menus and tool bars and existing commands can be changed. It is possible to create new menu and tool bar symbols for commands, that do not have a symbol associated with it by default, or to change existing icons with a built-in icon editor.

It is furthermore possible to display all menu and toolbar icons in large size.

Keyboard accelerators can be changed. It is also possible to assign keyboard accelerators to commands, that do not have a keyboard shortcut associated with it by default.

File Handling

The complete data of your model railroad layout is stored in one single file on the hard disk on your computer. This file is called layout file. You can create as many layout files as you like. For example, this is useful if you have different model railroad layouts or if you want to try and store several variants of the same layout file.

The layout file contains the complete description of your layout, i.e. all track diagrams, routes, trains and all data specified for automatic control of the layout, if any. The file also contains the current status of your model railroad layout, i.e. the current state of all turnouts and signals, the status and positions of trains, etc. Finally the current layout and settings of the user interface are stored in the layout file, too. Please note that all data of the same layout is stored in the same layout file.

Layout files are created, opened and stored through the Railroad menu of the software.

Please note the difference between windows and files. Only one layout file can be opened at the same time and the layout file contains all data and windows that belong to the same layout. The windows belonging to the same layout are contained in one layout file.

Edit Mode

All changes to be made to the content of your layout file require that TrainController™ Bronze is running in edit mode. While edit mode is turned on you can change data, add new data or delete data, that is no longer needed. During operation
edit mode is turned off. This protects your data during operation against unintentional changes.

Edit mode can be turned on or off at any time. When edit mode is turned on all automatic operation of your layout, if any, is stopped.

![Warning]
In order to input new data as well as to edit or delete existing data edit mode must be turned on.

Further Steps

In order to control your model railroad layout with TrainController™ Bronze, you need one or more of the digital systems listed in the previous section. These digital systems are connected to an available serial, USB or Ethernet port of your computer.

In the following it is assumed that you are already familiar with the usage of your digital system. For details regarding your digital system, please refer to the documentation provided by the manufacturer.

To create a computer control system with TrainController™ Bronze the following steps are usually performed:

- Creation of a Switchboard containing a control panel based on a track diagram
- Entering the data of existing trains
- Creation of automatic schedules with the Dispatcher

It is not necessary to perform all steps listed above to control your model railroad with TrainController™ Bronze. For model railroad clubs you may only need to arrange the Switchboard. In this case, one person may be responsible for controlling the traffic by operating turnouts, signals and routes while other persons are using handheld throttles to control the trains. If you have an existing control panel, then you can use the Train Windows independently to take advantage of the realistic train control features of the program.

Switchboard

Usually, you will start configuring TrainController™ Bronze by creating a Switchboard. Like in real railroads, Switchboards are control panels to be used to control turnouts, signals, routes and other accessories like uncouplers or crossing gates. Switchboards are made using symbol elements representing tracks, turnouts, crossings, signals, accessories and more.
A *Switchboard* is usually created for those parts of the layout that contain turnouts, and signals. Examples of such areas are stations, sidings or hidden yards.

You first insert track elements into the *Switchboard* to create a track diagram that represents the track plan of your entire layout, the main station or any yard etc. This switchboard is also used as a base for quick and easy setup of automatic operation.

After you have placed all tracks, turnouts, crossings and bridges in the correct positions, you specify the *digital addresses* of your turnouts.

When this has been done, you are able to control the turnouts of your model railroad with *TrainController™ Bronze* and your computer.

Your model railroad may contain not only tracks and turnouts but also signals and other accessories. If so, the next step is placing the *signals* at the appropriate locations of your control panel. *TrainController™ Bronze* provides symbols for *two, three and four aspect signals*. Uncouplers, lights, crossing gates or other accessories can be controlled with symbols representing *push buttons, toggle switches* or *on-off switches*.

After you have placed all the signals in the correct positions, you specify the *digital addresses* of your signals and other accessories.

Once you have specified the *digital addresses* of your signals and other accessories, you are able to control these objects manually with *TrainController™ Bronze*, also.

*Text elements* can be inserted at arbitrary positions to label your control panel. Images can be placed in the Switchboard as well.

If you want to set up automatic operation for your trains or display train positions in the switchboard, then you will need to insert *blocks* in your switchboard, that represent the blocks of your model railroad.

### Train Windows

The *train window* enables the operation of your *trains*. To control several trains simultaneously, you can open as many train windows on your computer screen as desired.

After the selection of the current engine, or train, in the train window, you are able to control the train and monitor its operations with the control instruments.
To operate a certain engine on your layout, create a *Train Window* and specify the digital address of the engine. You do not have to bother with all other options until you want to add more realism to the operation of your trains.

**The Visual Dispatcher**

The *Visual Dispatcher* is a component that makes large scale railroad operations manageable by one person, matching operations found on the largest club layouts. Engines and *trains* can be operated manually or automatically.

Like a human operator must know the overall structure of the model railroad layout the *Visual Dispatcher* needs to know this, too. This structure is represented by a diagram that contains blocks and routes and the track connections between them. This diagram is called *main block diagram* of the layout. The main block diagram describes the track layout of your entire model railroad in rough outline.

The *Visual Dispatcher* manages traffic flow using a blocking system. Blocking ensures that trains do not collide and supports the tracking of train positions. For this purpose, the railroad layout is divided into virtual, logical blocks. That means, you define blocks at locations where traffic control will take place (e.g. scheduled stops in a station).

Usually each track in a station or hidden yard, each siding and appropriate sections of the connections between two yards will form a block.

Dividing the layout into logical blocks does not necessarily imply, that your blocks must be electrically insulated. *TrainController™ Bronze* does not require such electrical insulation. Whether your blocks must be insulated or not depends solely on the hardware used.

*Blocks* and connecting *routes* are arranged graphically in the *main block diagram* to specify on which paths trains will travel. *Schedules* describe train movements, i.e. how trains travel. This includes start and destination blocks, scheduled waits, speed limits, etc.

*AutoTrain™*, an outstanding feature of *TrainController™ Bronze*, allows you to start trains automatically without the need to define a schedule before or to create new *schedules* while playing with your trains – programming while playing!

Trains can run under full manual control, in which case the human operator will be responsible for obeying the block signals set by the *Dispatcher*; or under full control of the computer; or even with an intermediate level of automation.
Randomizer functions increase the diversity of your model railroad traffic.
2 The Switchboard

2.1 Introduction

By default TrainController™ Bronze displays a switchboard in the main window of the software. The switchboard represents a track diagram control panel of your layout.

Switchboards are used to operate the turnouts, signals, routes and other accessories, like crossing gates, on your model railroad. Switchboards are created using different symbol elements that are arranged in rows and columns.

Several types of symbol elements are provided to facilitate the creation of switchboards:

- **Track elements** are used to represent the tracks of your model railroad such as straight and curved tracks.
- **Turnout elements** are provided as special track elements to enable operation of different types of turnouts like normal, triple or slip turnouts.
- **Signal elements** are used as two, three or four aspect signals to represent and to operate the signals on your model railroad.
- **Accessory elements** of several types – push buttons, toggle switches or on-off switches – operate additional accessories such as uncouplers or lights.
- **Block Symbols** can be used for quick setup of automatic operation and display of train positions.
• Text elements can be used as labels, e.g. for tracks in stations.
• Images can be inserted into your track diagrams to display landscapes, buildings, streets or other objects of your model railroad.

The following elements can be additionally added to switchboards in specific cases:

• Route elements enable manual route operation and locking on layouts.

The following steps are performed to create a full functioning switchboard:

• Drawing the track diagram of the related area
• Connecting turnouts and signals
• Inserting block symbols
• Placing signals and accessory elements
• Adding text labels and images

The following steps are mainly performed in the switchboard in those cases where it is desired, to monitor the traffic on the layout to a certain degree, or to achieve semi-automatic operation of the layout without running the Visual Dispatcher. If the Visual Dispatcher is being used, the following steps are performed in the Visual Dispatcher rather than a switchboard.

• Creating manual routes

2.2 Size and Appearance

For each switchboard it is possible to customize the size, i.e. the numbers of rows and columns, and the appearance individually.

The elements in the switchboard are arranged in a grid based system consisting of rows and columns (see Diagram 48). The number of rows and columns is not limited. If a large switchboard cannot be displayed on the screen, then the visible display section can be scrolled. This is also possible by clicking and dragging the switchboard with the middle mouse button.

The individual preferences with regard to the appearance of track diagram control panels are very different. For this reason TrainController™ Bronze provides many options to customize the appearance of the control panels individually to your convenience and taste. There are options to select the background and track colors, to apply 3 dimen-
sional light and shadow effects to background and tracks and to select the colors in which the states of certain elements are highlighted.

The possibilities are virtually unlimited, a few examples are given below:

Diagram 49: Standard Format

Diagram 49 shows the standard format for display of control panels. A few examples of the unlimited possibilities to customize the appearance are given in the following:

Diagram 50

Diagram 51

Diagram 52
2.3 Drawing the Track Diagram

Creating a switchboard starts with drawing the track diagram of the layout. Using the available track elements a schematic image of the tracks of the layout is drawn on the computer screen.

The following track elements are available:

- **Straight**
- **Normal or narrow Curve**
- **Bumper**
- **Diagonal or vertical crossing**
- **Diagonal or vertical bridge**
- **Left- or right-hand turnout as well as well as Wye-Turnout**
- **Three way turnout**
- **Single or double slip turnout**

You can draw your track diagram in various ways. First, though, the edit mode of the switchboard must be turned on.

Then you have the following options:

- **Inserting single elements:** You can draw your track diagram by inserting single elements successively.
- **Drawing a straight track section with the mouse:** You can draw a straight track section consisting of more than one element very quickly by dragging the section you want to draw with the mouse.
- **Drawing the track diagram with the keyboard:** An additional and fast way to draw the track diagram is the use of the numeric keypad of your computer.

These methods are explained in detail in the help menu.

To adjust the track elements precisely, additional edit facilities such as *copy*, *move* or *turning* of track elements are available.

2.4 Connecting the Turnouts

When the track diagram is completely drawn, the digital address of each turnout, or slip turnout, must be specified. This is the address of the stationery decoder or output device controlling the specified turnout.
This is done by selecting the turnout element and using the **Properties** command of the **Edit** menu.

For each turnout you can specify a *name*. This is useful in identifying the turnout when it is referred to later.

![Diagram 58: Specifying the name of a turnout](image)

Turnouts with more than two states such as *three way turnouts* or *single or double slip turnouts* with four solenoids occupy two digital addresses. For simplicity, **TrainController™ Bronze** always uses the *subsequent address* by default.
For *double slip turnouts* it is possible to specify whether the turnout is operated by two or four solenoids.

Depending on the digital system being used, or the way the turnout is wired, the turnout element in the switchboard may not reflect the correct position of the real turnout. To correct this problem, you do not need to rewire your turnout. The software allows you to setup the configuration of the decoder outputs in any way as required to operate the turnout.
The image above displays two possible configurations for a double slip turnout. In both cases it is assumed that the turnout is operated by two double-solenoid devices with four solenoids in total. For this reason the turnout occupies four output contacts of an accessory decoder. The left image displays a situation, in which both double-solenoid devices must be operated in order to throw the turnout. The right image displays a situation, in which only one double-solenoid device is to be operated to throw the turnout. The bright circles represent the contact outputs of the accessory decoder which are turned on in order to throw the turnout to the corresponding state. The dark circles correspond to the decoder outputs, which remain turned off during operation of the turnout.

For certain digital systems the bright circles are drawn in a color or show an additional sign, which reflects the color or label of the key, that is to be pressed on the keyboard or handheld of this digital system in order to activate the related contact output. If you are familiar with the operation of a certain turnout with your keyboard then these additional markings help you to map the keyboard operation to the correct configuration in the software.

These images display only two possible situations. The decoder outputs can be configured very flexibly as required to operate the turnout.

2.5 Signals and Accessories

After completing the track diagram, the next step is to place the signals in the diagram, as well as the accessory elements such as operating lights, uncouplers or other accessories.

The following elements are provided:

- *Two, three and four aspect signals* of different styles
- *Push buttons, toggle switches or on-off switches* to operate your accessories

![Diagram 61: Attaching signals and accessories to the track](image)

If you want to visualize that a signal or accessory element located in the track diagram is associated with a piece of track on your railroad (for example a signal that controls a
track section or a push button that operates an uncoupler), you can attach this element to a track element. For the operation of the signal or accessory element, however, it is not important if it is attached to the track or not. The purpose of the attachment is only to visualize the relation between the signal, or accessory element, and the corresponding track.

**Signals**

It is important for the operation of the signal that you differentiate between the symbol for a *two, three or four aspect signal*.

**Accessories**

*Accessory elements* are used to control accessories like uncouplers, light or crossing gates. They are available in three different types:

- *Push buttons* are used to turn on a certain contact temporarily – e.g. to control an *uncoupler*
- *Toggle switches* are used to change permanently between two related contacts
- *On-off switches* are used to turn on and off a certain contact permanently – e.g. to turn on and off lights

**Connecting Signals and Accessories**

Signals and accessories are connected to their real counterpart on the model railroad much like the turnouts as outlined in section 2.4, “Connecting the Turnouts”. This is also done by selecting the symbol of the signal, or accessory, in the switchboard and using the **Properties** command of the **Edit** menu.

**2.6 Text Labels**

You can place text labels in your control panels. For this purpose, *text elements* are provided and can be used to label turnouts, signals or tracks.
2.7 Self-provided Switchboard Images

Images

It is possible to display images stored in external bitmap, gif or jpeg files in your switchboard. The following options are provided:

Images can be arranged in the background, i.e. behind the track diagram, or in the foreground of the switchboard. Images in the background can be covered by track elements or by images laying in the foreground. Such images can be used to display landscape structures like meadows or rivers. Images in the foreground can cover track elements and can be used to display buildings, bridges or tunnels.

It is additionally possible to fade out portions of an image, i.e. to draw portions “transparently”. This is useful if images with irregular shapes are drawn. This is done by drawing the parts of the image, which will be drawn transparently, with a particular color, which is not used elsewhere in the image.
2.8 Displaying Train Names and Symbols in the Switchboard

The names or symbols of trains located in a certain block are displayed in the switchboard in the block symbols. These are symbols, that are associated with blocks. Block symbols are able to show the status of the related block as well as an image and/or the name of the train, that is currently located in the block, if any. For further details please refer to section 5.5, “Train Tracking”.

Block symbols are also used for quick and easy setup of automatic operation of your trains. These symbols mark the location of the blocks of your layout in the track diagram.
3 Train Control

3.1 Introduction

The Train Window

Train windows can be used to operate trains manually with the mouse or keyboard of the computer or to watch the status of running trains during operation.

Train windows contain various controls and instruments, that are used to operate or to monitor each train.

A sample Train Window is displayed below:

![Diagram 63: Train Window](image)

Train windows provide among others the following features:

- The size of the train window can be continuously adjusted. This is possible on the fly, like any other window, by dragging the borders of the train window with the mouse.
• It is also possible to define an ideal size for train windows. The ideal size of each train window can be restored at any time with a single mouse click.
• The symbol or the name of the currently selected train can be displayed.
• The sizes of the particular groups of instruments can be individually adjusted. TrainController™ Bronze is able to switch dynamically between a small and large display mode according to the available space. It is furthermore possible to hide individual and not needed groups of instruments in order to save space on the computer screen.
• The number of steps for operation of the throttle control with the computer keyboard can be individually set. A specific setting allows the throttle to follow the number of physical speed steps of the controlled decoder.
• The throttle can be arranged with the zero position in the middle or on the left.
• The throttle can be set to operate train oriented or layout oriented. A train oriented throttle causes the train always to move forward, when the direction control is pointing to the right, and to move backward, when the direction control is pointing to the left. A layout oriented throttle causes the operated train to move to the left on the layout, when the direction control is pointing to the left, and to move to the right on the layout, when the direction control is pointing to the right. This setting is only effective for trains currently assigned to a block (see section 5.2, “Blocks and Routes”). If the block is aligned vertically on the computer screen, then the train will move to the top or bottom, when the direction control is pointing to the top or bottom, respectively. This setting emulates the characteristics of a former throttle for analogue DC railroads.
• The throttle can be set to operate the speed of the train (less realistic, but more convenient) or the power of the train (more realistic, but less convenient). If the throttle controls the speed, then the train is always accelerated with the maximum engine power. Dragging the throttle to a certain position causes the same effect, as if the throttle were first dragged to the maximum position and then reduced to this position, when the train reaches the corresponding speed. If the throttle controls the power, then the train is always accelerated with the power, that corresponds to the slider position. This provides more realistic train control, because many throttles of real railroads actually control the effective power rather than the speed of the train. In such cases the speed indirectly “follows” the effective power. This option, however, also requires more complex user intervention for train control and is less convenient than direct speed control. It is also possible to set individual throttles to operate trains without any momentum.
• The colors and layout of the speedometer and odometer can be individually customized with a wide variety of options.
• The speedometer can be made sensitive. In this case the speed of the currently selected train can be changed by clicking to the scale of the speedometer with the left mouse button.
• The currently set target speed can be optionally made visible with a specific marker. The color of this marker can automatically change according to the current direction of travel, if desired, or be set to a constant color.
• All the above settings can be reset to factory defaults at any time, if desired.

Train List

The Train List of TrainController™ Bronze is used to manage and operate your engines and trains.

The Train List holds all engines and trains defined in the software and displays additional status information for each train.

Diagram 64: Sample Train List

The train list provides the following columns:

• **Train**: an image of the train
• **Name**: name of the train
• **Type**: train type
• **km/h** or **mph**: current speed and direction
• **Sig.**: current signal
• **Mode**: mode of operation
• **State**: status indication
• **Schedule**: currently performed schedule
• **Block**: current location

In the train list each engine or train can be selected to change its properties or to operate it.
Each item in this list shows the name and the image of the train. To prepare train images for display in TrainController™ Bronze a complementary software program called TrainAnimator™ is available free of charge.

TrainController™ Bronze expects the image data to be stored in a certain format and scaled to a certain size. The images must fit to the proportions of the screen display of TrainController™ Bronze. Additionally the images of several trains should fit together with regard to their scale, regardless of the origin of each image. TrainAnimator™ is able to process several image formats, among others bitmap, JPEG or GIF. It is also able to extract images, that are stored in application programs or screen savers. TrainAnimator™ converts the different data formats and image sizes to a standardized and scaled format, which can be used by TrainController™ Bronze without further conversion.

The images displayed in Diagram 64 have been processed with TrainAnimator™. Even though the original formats and sizes of the particular images displayed above are very different, they have been converted and scaled to fit together.

3.2 Engines

An engine describes different properties of one of your model engines. These are prototypical attributes like maximum speed or power, or model related properties like digital address or auxiliary functions.

For operation of your engines it is sufficient to enter each engine with its digital address in TrainController™ Bronze To specify the digital address or other attributes mark the appropriate engine in the Train List or in a Train Window and select the Properties command of the Edit menu. Once an engine is entered with its digital address it is then possible to control it with the train window.
Diagram 65: Digital Address of an Engine
3.3 The Throttle Control

The throttle is used to control the speed of each engine. The zero position of the throttle is located in the middle. When the slider of the throttle is in the rightmost position, the train runs forward with maximum speed. Conversely, the maximum backward speed is achieved by pulling the slider to the leftmost position.

It is also possible to set the zero position of the throttle to the leftmost position of the throttle control. In this mode, the maximum forward or backward speed is achieved by pulling the slider to the rightmost position. The direction of the engine is controlled by the separate direction selector.

The above sections describe the train oriented mode of the throttle control. In this mode, the throttle causes the train always to move forward, when the direction control is pointing to the right, and to move backward, when the direction control is pointing to the left. In the layout oriented mode, the throttle causes the operated train to move to the left on the layout, when the direction control is pointing to the left, and to move to the...
right on the layout, when the direction control is pointing to the right. This setting is only effective for trains currently assigned to a block (see page 108). If the block is aligned vertically on the computer screen, then the train will move to the top or bottom, when the direction control is pointing to the top or bottom, respectively. This setting emulates the characteristics of a former throttle for analogue DC railroads.

In addition to the throttle two additional buttons can be displayed in the train window, if desired, with which the speed of trains can be increased or decreased in single steps, and thus very precisely. If desired a third button can be made visible, with which the throttle can be set directly into the zero position.

For each *engine* you can specify the *maximum scale speed*. This value is used as the maximum speed with which an engine is controlled by *TrainController™ Bronze* To run an engine with maximum speed the throttle slider must be pulled to the maximum position.

![Diagram 67: Speed Properties of an Engine](image)
For each engine you can also specify the threshold speed. This is the minimum speed at which the engine runs smoothly. The threshold speed is used if the throttle slider is moved out of the zero position. In this way “dead zones” near the zero position of the slider are avoided. For engines which will run automatically under control of the Dispatcher (see chapter 5, “The Visual Dispatcher”) we recommend that you adjust the threshold speed accordingly.

### 3.4 Speedometer and Odometer

The speedometer displays the current scale speed of an engine or train. The scale speed is calculated using the real speed on the model railroad layout and the scale of the model. If a train with scale 1:87 (H0) is running with a real speed of 1 mile per hour on the model railroad layout, then this speed corresponds to a scale speed of 87 miles per hour.

In conjunction with an internal constant scale factor scale the simulated distance is calculated. This simulated mileage is displayed on the odometer.

### 3.5 The Simplified Speed Profile

To enable the program to display an estimated scale speed on the speedometer we recommend that you adjust the speed profile for each engine.

The speed profile is a table that records which virtual speed step corresponds to which scale speed. **TrainController™ Bronze** internally works with 1000 virtual speed steps for each direction regardless of the characteristics of the engine decoder used. When a speed command is sent to the decoder, then the virtual speed step is matched to the appropriate physical speed step of the decoder.

#### Preparing the decoder

Before adjusting the speed profile, the decoder of the locomotive, if any, should be prepared accordingly. This should be done to achieve the best possible operation. Perform the following steps prior to adjustment of the speed profile:

- Set the start voltage to a value, at which the locomotive begins to run smoothly.
- Trim the maximum speed of the decoder in a way, that the desired maximum scale speed of the locomotive corresponds to the highest speed step of the decoder. If, for example, your decoder has 28 speed steps and the maximum scale speed of the lo-
comotive should be 100 mph, then adjust the maximum speed of the decoder in a way, that the locomotive runs about 100 mph at speed step 28.

- Set the deceleration momentum of the decoder to a minimum value. This is just the value, at which no abrupt speed change of the real locomotive can be noticed anymore, when changing from one speed step to another.
- Adjust the speed table or the mid voltage of the decoder, if any, and its acceleration momentum to any settings, that you feel convenient with.

**The simplified Speed Profile**

The software allows editing of a simplified profile. This simplified profile describes the speed characteristics of your engine approximately and with identical settings for both directions of travel. It contains the following entries:

- An entry, that describes the threshold speed. This is the minimum virtual speed step (out of 1000) at which the engine begins to run smoothly. This value is adjusted by letting the engine run as slowly as possible, but also smoothly. If this is achieved the current speed value is stored into the software.
- An entry describing the speed step, that corresponds to a pre-set slow speed. Let the engine run at this speed (e.g. by measuring the speed with a stop watch) and store this value into the software.
- An entry describing the speed step, that corresponds to the maximum speed of the engine. This value is determined and stored in the same way as the other two values.
- An entry describing the braking ramp, that is effective, when the engine is stopped during automatic operation. If the engine is decelerating too slowly or stopping too late during automatic operation, then this value can be easily adjusted.
3.6 Headlights, Steam and Whistle

For each engine an arbitrary number of engine function controls (e.g. light, sound, smoke, etc.) can be defined. Each function can perform one of the following:

- activating a built-in function of an engine decoder
- playing a sound file

Engine Functions can be executed by using the auxiliary function controls of the train window.

You can specify an individual tip for each function. This is arbitrary text which is displayed in a small popup window, when the mouse is moved over a function button in the Train Window. This tip text helps to distinguish between different functions that are associated with similar function symbols (such as Light 2, Light 3, ...).

The function actually executed may be different from engine to engine. This is illustrated by the following example. It is assumed, that a built-in sound function of the corresponding engine decoder is assigned as Sound 1 to a diesel engine and playing a sound...
file with a typical sound of a steam engine is assigned as *Sound 1* to a steam engine. If the function *Sound 1* is executed, then the built-in decoder function is activated for the diesel engine and the specified sound file is played for the steam engine.

Each function, which is assigned to a built-in function of an engine decoder can be turned on permanently (e.g. *Light* or *Steam*) or temporarily (e.g. *Whistle* or *Coupler*). For this reason the auxiliary function controls in the train window can be arranged as on/off switches or push buttons.

![Diagram 69: Arranging Auxiliary Functions](image)

### 3.7 Passing control between Computer and Digital System

Initially, control of each *engine* is assigned to the computer. This means that the software assumes that it has full control over the engine.

With specific menu commands, dependent on the digital systems used, it is possible to pass control from the computer to the digital system and vice versa. For certain digital
systems these menu commands are disabled, because these systems are able to pass control automatically (see below).

If control is passed from the computer to the digital system then control of the related digital address is passed to a handheld of the digital system. Additionally – if supported by the digital system - TrainController™ Bronze begins to monitor speed and function changes of this engine and reflects such changes in the Train Window accordingly.

**For train tracking (see section 5.5, “Train Tracking”) of an engine it is important that the software knows the direction and speed of a running engine. If you want to control an engine with a handheld of your digital system under simultaneous train tracking, then it is necessary to assign control of the engine to the digital system before, if this is not done automatically (see below).**

If an automatic schedule of the Dispatcher (see section 5.11, “Schedules”) is executed with an engine currently under control of the digital system, then control of this engine is temporarily passed to the computer. After finishing the schedule, control is passed back to the digital system. Such transfers of control are performed by the software automatically if needed.

**Assigning control of an engine to the computer is necessary, if you want to control the engine **manually with the on-screen throttle.**

**For those digital systems, where the assignment of control is done automatically, no manual intervention is required. The appropriate menu commands are therefore locked.**
4 Contact Indicators

If your digital system is able to report the state of track contacts, reed contacts, optical sensors, track occupancy sensors or other feedback sensors to the computer, then you can indicate the status of these contacts and sensors with contact indicator symbols. With these indicators, you are able to monitor the state of the feedback sensors on the computer screen.

Contact indicators are used in TrainController™ Bronze for occupancy indication of blocks for tracking and control of trains (see chapter 5, “The Visual Dispatcher I”).

If your digital system is not able to report the state of feedback sensors to the computer, then TrainController™ Bronze makes it possible to connect a second digital system to your computer. For this purpose a low cost digital system that is dedicated to the monitoring of feedback sensors is sufficient. More details about connecting a second digital system simultaneously are outlined in section 11.2, “Connecting a Second Digital System for Feedback Control”.

Feedback sensors are divided into momentary track contacts and occupancy sensors. In TrainController™ Bronze the same symbol is used for both types of contacts. The difference between both types of contacts does not play an important role as long as trains are not operated under control of the Visual Dispatcher (see section 5, “The Visual Dispatcher”).

**Momentary Track Contacts vs. Occupancy Sensors**

*Momentary track contacts* are turned on for a short period, when a train passes a certain point on the model railroad. They stay turned on only for a short period and are turned off as soon as the train moves any further. In Diagram 70 to Diagram 72 you can see a momentary contact triggered by a passing train. Momentary track contacts indicate that a train is about to pass a certain point. *Occupancy sensors* are turned on when a train enters a certain section on the model railroad. They stay turned on until the train leaves that section completely. Occupancy sensors indicate that a train is located inside a certain track section. In Diagram 73 to Diagram 76 you can see an occupancy sensor turned on and off by a passing train. Occupancy sensors are able to report the presence of a train inside a certain track section even if the train is not moving. Momentary contacts are triggered by moving trains only. Momentary contacts can be made for instance by mechanical track contacts, reed contacts or optical sensors. Occupancy sensors are often based on current sensing in isolated track sections.
Unlike other programs which require occupancy sensors for automatic train control, **TrainController™ Bronze** is also able to control trains if only momentary track contacts are used. Occupancy sensors are safer, though, because with momentary contacts special measures against premature release of blocks must be taken.

The following diagrams show the behavior of a momentary contact in the different phases while a train is passing. The position of the momentary contact is marked with a short vertical line.

**Diagram 70**: Train is approaching the momentary contact – the contact is turned off

![Diagram 70](image)

**Diagram 71**: Train is reaching the momentary contact – the contact is triggered

![Diagram 71](image)

**Diagram 72**: Train is leaving the momentary contact – the contact is turned off

![Diagram 72](image)

The following diagrams show the behavior of an occupancy sensor in the different phases while a train is passing. The track section sensed by the occupancy sensor is marked with a horizontal line.
Diagram 73: Train is approaching the occupancy sensor – the sensor is turned off

Diagram 74: Train is located inside the sensed section – the sensor is turned on

Diagram 75: Train is still located inside the sensed section

Diagram 76: Train has left the sensed section – the sensor is turned off
There is one major difference between momentary contacts and occupancy sensors to remember: the points at which the indicators are turned on. A momentary track contact is turned on when a train reaches a certain point on the layout regardless of the direction of travel of the passing train. In this way a momentary track contact represents one single sensing point on the model railroad. An occupancy sensor is turned on when a train reaches either end of the sensed track section depending on the current direction of travel of the passing train. In this way an occupancy sensor represents two different sensing points on the model railroad. It depends on the direction of travel of a passing train at which of these two points the train triggers the sensor.

Even though the software works well with both types of sensors, momentary and occupancy, it is important to ensure, that the indicator symbol, that is associated with a certain sensor, is only turned on once by each passing train, even if the physical sensor is triggered two or more times by the same passing train. Indicator symbols, that are turned on two or more times by the same passing train ("flickering") may mislead the software and can cause unexpected behavior of the affected trains. This is especially true for trains running under automatic control of the computer. Each indicator symbol, that is being passed by a train under automatic control of the computer, should be turned on only once by the passing train.
5 The Visual Dispatcher I

5.1 Introduction

A human operator is normally only able to operate the switchboard and at most two trains at the same time. If a certain number of trains are to be operated at the same time, then either support of additional human operators is required, or a component like the Visual Dispatcher, which is able to take the place of additional human operators.

The Visual Dispatcher (or in a word Dispatcher) is a component that makes large scale railroad operations manageable by one person, matching operations found on the largest club layouts.

Like a human operator the Visual Dispatcher is able to operate turnouts, signals, routes and trains. This is called automatic operation.

A broad range of operating flexibility is provided from completely manual through to fully automatic operation (e.g. hidden yard control). Manual and automatic operation can be mixed simultaneously. This applies not only to trains on different areas of your railroad, but also to different trains on the same track and even to the operation of a single train. Automatic processes are not bound to specific trains. Once specified they can be performed by each of your trains. There is no need to learn a programming language. Built-in train tracking functions display on the screen which engine/train is on which track.

Like a human operator must know the overall structure of the model railroad layout the Visual Dispatcher needs to know this, too. This structure is represented by a diagram that contains blocks and routes and the track connections between them. This diagram is called main block diagram of the layout. The main block diagram describes the track layout of your entire model railroad in rough outline.

The Visual Dispatcher manages traffic flow using a blocking system. Blocking ensures that trains do not collide and supports the tracking of train positions. For this purpose, the railroad layout is divided into virtual, logical blocks. That means, you define blocks at locations where traffic control will take place (e.g. scheduled stops in a station). Usually each track in a station or hidden yard, each siding and appropriate sections of the connections between two yards will form a block.
Blocks are arranged graphically and connected by routes to specify on which path a train will travel from certain starting blocks to destination blocks. Schedules describe train movements, i.e. how trains travel. This includes scheduled waits, speed limits, etc.

Trains can run under full manual control, in which case the operator will be responsible for obeying the block signals set by the Dispatcher; under full control of the computer; or even with an intermediate level of automation.

Schedules can be arranged with a broad range of flexibility. Random functions increase the diversity of your model railroad traffic.

Creating a model railroad operation system with the Dispatcher is done by performing the following steps:

- Divide the model railroad layout into blocks and enter these blocks into TrainController™ Bronze
- Arrange blocks and routes between them in the main block diagram. This diagram will represent the track layout of your entire model railroad in rough outline.
- Arrange schedules

These steps will be outlined in more detail in the following sections. We will do this by looking at the following sample layout:
Diagram 77: Sample Layout

The layout has two stations: “Southtown” located on the left side of the layout and “Northville” located at the end of a branch line. There is an additional hidden yard that is covered by the mountain.

This can be seen better in the track plan displayed below:
The main line, i.e. the loop that connects “Hidden Yard” and “Southtown”, will be operated automatically under full control of the *Visual Dispatcher*. The branch line from “Southtown” to “Northville” will be operated manually.

The parts of the layout that are covered by structure and therefore invisible are drawn here in a slightly brighter color.

The first step is drawing of a switchboard for the layout displayed above. It looks as follows:
The next steps, that are required to configure this layout in the *Visual Dispatcher*, are outlined in the following sections.

## 5.2 Blocks and Routes

### Blocks on the Layout

The *Visual Dispatcher* manages traffic flow using a *blocking system*. Blocking ensures that trains do not collide. For this purpose the railroad layout is virtually divided in logical blocks. That means, you define blocks at locations, where traffic control will take place (i.e. stopping inside a yard) or where trains are parked. Blocks are also used to determine and to indicate the position of your engines and trains on your tracks.
Typical examples of blocks are

- Tracks at a platform
- Sidings in a (hidden) yard
- Block sections on tracks between two stations

In most cases blocks contain only a straight track section and no turnouts. They are usually limited by two turnouts on both sides or by a turnout and a dead end of the track. Block sections between two stations are often limited by block signals.

Some guidelines for arranging your blocks:

- Blocks may be located anywhere on your railroad.
- Blocks are often limited by turnouts. These turnouts usually do not belong to the blocks.
- Blocks should be long enough to hold each stopping train completely.
- Each location, where the Visual Dispatcher will be able to stop a train automatically (e.g. in a station or in front of a signal), should be located in a separate block, i.e. in order to stop two trains at the same time at different locations, these locations must be arranged in different blocks.
- The more blocks are provided the more trains can be run simultaneously under control of the Visual Dispatcher.
- Each block can be reserved by at most one train. A specific train may reserve several blocks. A train, that runs under control of the Visual Dispatcher, may only enter blocks, that are reserved for this train.
- Blocks only need to be provided for the parts of your model railroad, which will be controlled by the Dispatcher. Parts without blocks are not visible to the Dispatcher.
Following these guidelines the block structure of the sample layout looks as follows:

![Diagram 80: Block structure of the sample layout](image)

Each blue track section represents a separate block. The blocks on the main line or the branch line between “Southtown” and “Northville” can be subdivided further into more blocks if each of these blocks is long enough to store the longest train. This is useful if you want more than one train to travel on these tracks at the same time.

**Block Diagram**

Like a human operator must know the overall structure of the model railroad layout the visual dispatcher needs to know this, too. This structure is represented by a diagram, that contains blocks and routes between blocks. This diagram also displays the various itineraries of your trains. This diagram is called *block diagram* of the layout. It describes the track and block layout of your entire model railroad in rough outline.

The Block diagram is displayed in a separate window, the *dispatcher window*.

The switchboard, that you create for your layout, corresponds to a block diagram. This block diagram is created automatically by *TrainController™ Bronze* by using the track layout drawn in the switchboard and the information about the blocks contained therein. To enable *TrainController™ Bronze* to create ( “calculate”) a block diagram for a switchboard, it is necessary to specify the positions of the blocks in the track diagram of the switchboard, if there are any. This is done with the help of *block symbols*. 
By creating a switchboard, drawing a track diagram in it and inserting block symbols at positions, where blocks are located, **TrainController™ Bronze** will automatically calculate a block diagram for this switchboard. All connecting routes will be automatically calculated, too, with all contained turnouts. No extra human intervention is necessary to accomplish this.
Blocks are displayed on the computer screen by rectangular boxes. The blocks are connected to each other by routes, which touch each box graphically at a smaller side. These routes are drawn as lines.

Please note that the block diagram represents the track layout in rough outline. The actual track connection between “Main Line West” and “Hidden Yard 3”, for example, contains two turnouts. These turnouts are not drawn in the block diagram in detail or as separate objects. Instead a line between the blocks is created, that indicates, that there is a track connection between the blocks.

In order to enable TrainController™ Bronze to calculate the block diagram automatically note the following:

- Draw the complete track diagram of your layout with all turnouts and crossings and without any gaps in a switchboard window.
- Create block symbols for all blocks of the layout, place them according to their location on the actual layout and ensure, that they are turned horizontally or vertically according to the track symbols, to which they are attached.
- Ensure that the blocks are connected to each other by track symbols without any gaps. The connecting tracks must touch the blocks at the smaller sides.
When working with **TrainController™ Bronze** you may notice, that switchboards and their corresponding block diagrams seem to look almost identical at first glance. But this is not actually the case. Switchboards contain the details of the track diagram, i.e. each particular track symbol and turnout and also additional objects like signals, push buttons etc. Switchboards are also the base for you to operate your layout, i.e. to perform manual interventions during operation. In contrast, block diagrams display routes between blocks rather than single track or turnout symbols and no additional objects like signals or buttons. Block diagrams mainly serve to manage the blocks and routes and to define and manage predefined itineraries for your trains (“schedules”). They can also be used to monitor the traffic on your layout but are usually not used for manual intervention. In many cases you will display the block diagrams only during edit mode to manipulate your data but hide them during operation.

**Routes between Blocks**

In order to let trains run from one block to another the blocks must be linked together. This is done with the help of *routes*. In the block diagrams routes are represented by lines that connect one block with an adjacent block.

Each block has two entries/exits. If a block is passed horizontally, then the entries/exits are graphically located on the left and on the right side of the block. If a block is passed vertically, then the entries/exits are located at the top and at the bottom. Each route begins at the entry/exit of a block and ends at the exit/entry of an adjacent block.

The following image explains the terms once more:

![Diagram 83: Blocks and Route](image)

In the diagram displayed above the blocks “Southtown 1” and “Main Line East” are connected with a route.

In many cases the track connection between two blocks contains one or more turnouts. In Diagram 81, for example, the route between Block “Main Line East” and “Southtown 2” contains two turnouts. To enable a train to travel automatically from one block to another the route between both blocks is activated. When this happens, all turnouts con-
tained in the route are operated accordingly. All track elements along the path of the route remain locked in this position until the route is turned off again. As long as these elements are locked, they cannot be operated or used by other routes.

5.3 Direction of Travel vs. Engine Orientation

It is important to understand the difference between direction of travel and the orientation of an engine.

**Direction of Travel**

*Direction of travel* is seen from the passenger's point of view. For the passenger sitting in a train it is important to know, whether the train runs from the east to the west, from the city to the country, or from the sea to the mountains. The direction of travel has a “geographical” meaning. Each *block* can be passed in one of two directions at a time. For each train controlled by the Dispatcher the Dispatcher must know the train's intended direction of travel. This information is derived by the Dispatcher from the arrangement of the blocks in the related diagrams and the routes that connect these blocks.

**TrainController™ Bronze** draws each block to represent one pair of corresponding directions. Each block can be either passed horizontally (from the left to the right or back) or vertically (from the top to the bottom or back).

![Diagram 84: Block Diagram of a Circular Layout](image)
In the diagram displayed above the direction of travel of each block is here indicated by an arrow. **TrainController™ Bronze** does not display these arrows, though, but displays small signal symbols on two sides of each block, to mark the direction of travel, that belongs to the block.

The direction of travel will correspond to the drawing of the block in the diagram. A block that is passed horizontally will be drawn as a horizontal rectangle while a block that is passed vertically will be drawn as a vertical rectangle. This is shown in the diagram displayed above.

**Engine Orientation**

*Engine Orientation* is seen from the engineer's point of view. It is not important for the passenger. The engine orientation describes the direction of the engine's head. For an engineer, who has to run a train in a certain direction of travel it is also important to know the engine's orientation, i.e. the direction of the engine's head. Depending on the intended direction of travel and the engine's orientation the engineer can decide, whether the engine is to be run forward or backward.

When the *Dispatcher* runs a train, it acts like an engineer. Both items of information - the intended direction of travel and the engine's orientation - must be known by the Dispatcher to start the train correctly.

The orientation of each engine is specified during assignment of an engine or train to a block. There are several methods to assign trains to a block. The most convenient method is to drag & drop a train icon to the symbol of a block. **Please always check that the current orientation of the engine matches the screen display.** In the case both do not match it is possible to revert the screen display with appropriate menu commands.

Another method for automatic assignment of trains to blocks is the use of train tracking (see 5.5, “Train Tracking”).

### 5.4 States of a Block

The different states of a block are determined by the fact whether the block is *occupied* or whether it is *reserved* for a certain *engine* or *train*. 
**Occupied Block**

A block is assumed to be *occupied*, if at least one of the *indicators* assigned to the block is turned on.

**Reserved Block**

Each block can be manually or automatically *reserved* for an *engine* or *train* by the Dispatcher. Reservation serves to support the following goals:

- Since a block can be reserved only for at most one *engine* or *train*, train collisions are avoided if blocks are arranged and reserved correctly.
- The program is able to determine, in which block a certain engine or train is located. This enables operations tied to the locality of trains - for example stopping a train in front of a red signal.
- The use of *block symbols* allows indication of train positions in the *switchboard*.
- Train tracking is based on dynamic and automatic reservation of blocks, too (see 5.5, “Train Tracking”).

**Current Block**

Among the blocks, which are reserved for a train, there is a special block, where the head of the train is assumed to be located. This block is called the *current block* of the train. Through the current block all block related operations which affect the speed of a train (like running with restricted speed) are performed.

In the beginning you must manually assign each engine or train to its current block. Afterwards this assignment is adjusted automatically by *TrainController™ Bronze* according to the position changes of the affected trains. Even after terminating and restarting of the program this assignment is automatically updated. Only if an engine or train is moved by hand to another track you must assign the engine or train to its new current block again.
When an engine or train is assigned to its current block, the current *engine orientation* must be specified. **TrainController™ Bronze** needs to know this orientation to be able to determine, if an engine will run forward or backward. **TrainController™ Bronze** adjusts the engine orientation accordingly even if an engine changes its orientation by passing a *reversing loop*.

**TrainController™ Bronze** provides several methods to assign a train to a block. The most convenient is to drag a train from the train list to the symbol of a block.

A reserved block must not necessarily be occupied. This is also true for the current block. If for example a train leaves its current block and temporarily no other blocks, that are reserved for this train, are occupied, then the current block is not changed, before the train enters another block and this block is indicated as occupied.
Display of Train Positions

The states of a block outlined are indicated by the concerning block symbols in the switchboard. In this way you can control in the switchboard, too, if a certain block is occupied or reserved. Block symbols display the name and/or the image of the train, that is currently located in the related block, in the switchboard. For further details refer to 5.5, “Train Tracking”, please.

Locking the entries of Blocks

Each block can be temporarily locked during operation. Locked blocks cannot be reserved by running trains. A train, that is already located in a block, when the block is locked, might stay there, though, and leave the block later. A lock does not also have an effect for a train, that has already reserved the block, before the lock is set. This train may proceed into the locked block.

Locks are directional. It is possible to set an individual lock for a particular direction of travel. This permits trains to pass the block only in one direction of travel. For this reason these locks are also called entry locks. The lock prevents trains from entering the block via the locked entry, while trains approaching the block from the opposite direction are not affected by this lock.

Please note that locking of a block affects all trains.

Locking the exit of Blocks

Each exit of any block can be temporarily locked during operation. A block cannot be left through a locked exit. Trains may enter such blocks and may stay there, but they cannot leave a block through a locked exit.

It is possible to lock either exit of each block individually and independently from the opposite exit.

Please note that locking of a block exit affects all trains.

5.5 Train Tracking

TrainController™ Bronze is able to indicate the positions of your engines and trains on the computer screen. This is always and automatically done in the screens of the Visual Dispatcher, such as the main block diagram or the particular schedule diagrams.
The block symbols in the switchboard also display the state of the associated block and optionally the name and/or image of the train that is located in this block.

![Diagram 86: Block Symbol in the Switchboard](image)

**Train Tracking**

The Visual Dispatcher uses the main block diagram to perform automatic train tracking. Whenever a block is reported as occupied, because one of the indicators assigned to it is turned on, then the Dispatcher checks, whether there is an appropriate train in an adjacent block. An adjacent block is a block that is connected with the current block with a route in the block diagram.

If there is such train, then the train is moved to this block. This is done by automatic assignment of the train to the new block and releasing of the previous block.

As a result of this movement the name and/or image of the engine or train appears in the block symbol of the related block in the Visual Dispatcher. Additionally, the train disappears from the symbol of the previous block. If there are block symbols in a switchboard window associated with these blocks, then the train movement will also be shown in these symbols.

If there is more than one train located in adjacent blocks, then the Dispatcher tries to determine the most probable candidate. For this calculation the speed of each train and the direction of travel, if known, or the occupancy state of each adjacent block is taken into account.

In order to achieve precise results it is important to assign the initial position and orientation of each train correctly. Additionally, you should always ensure that the software is able to track the direction and speed of each train. The control of trains that you operate with the throttle of your digital system should properly be assigned to the digital system (see 3.7, “Passing control between Computer and Digital System”).
• Under the conditions listed below train tracking works for each engine or train on the layout, which has been previously assigned to a block.
• The initial assignment of trains to blocks must be done manually.
• Train tracking is based on the block diagrams of the Visual Dispatcher and follows the specified routes between the blocks. The tracking of manually operated trains, such as those trains that you control with the throttle of your digital system, is only possible, if you create an appropriate main block diagram, that contains the proper routes between your blocks.

For train tracking of an engine it is important that the software knows the direction and speed of a running engine. If you want to control an engine with a handheld of your digital system under simultaneous train tracking, then it may be necessary to assign control of the engine to the digital system before you do this (see section 3.7, “Passing control between Computer and Digital System”).

5.6 Blocks and Indicators

For proper operation the dispatcher must be able to detect, whether a train occupies a specific section of your railroad or when a train passes a specific point on your railroad. This detection is done with contact indicators.
Diagram 87: The Block Editor

In order to establish a block, contact indicator symbols, which represent the track sensors located in this block, are created and assigned to the block. This is done with the block editor, which is displayed in Diagram 87. If at least one of the indicators contained in a block is turned on, then the block is assumed to be occupied. The actual layout positions of the sensors assigned to the block determine also the location of the block on your railroad.

The block editor shows an edit area with the current configuration of the block. Contact indicators are displayed as red rectangles in the center of the editor. Usually these rectangles represent the occupancy sections associated with each indicator (in the case of occupancy sensors) or the point in the block, where the indicator is triggered (in the case of momentary contacts like reed turnouts, mechanical contacts, etc.). Each physical sensor located in the block is represented by one indicator rectangle. The location and size of these indicator rectangles can be customized and do not have any impact for the operation of the program, but if properly arranged they can visualize the section, that is covered by a specific sensor.
In order to have control over the exact location, where a train will stop or change its speed inside a block, certain sections can be marked as stop or brake sections (see section 5.6, “Stop and Brake Markers”) or combinations of these.

To establish a block on your railroad, it is necessary to install the required sensors. Depending on the principle of the contact sensors used it may be necessary to electrically insulate the track section belonging to each contact sensor from adjacent sections. Whether electrical insulation is necessary or not depends solely on the contact sensors being used. The software does not require electrical insulation of your blocks.

- The software does not require that a block is electrically insulated from other blocks. However, the sensors used might require this.
- Blocks usually contain several indicators. If these indicators represent isolated or separate track sections, then several track sections are contained in the same block (see also 5.8, “Arranging Indicators and Markers in a Block”).
- The same indicator cannot be assigned to several blocks. In particular you should install your sensors on your layout in a way such that each sensor section is associated with at most one block.

5.7 Stop and Brake Markers

A block is established by creating and assigning one or more indicators to it. If at least one of these indicators was activated before and that at least one of these indicators is activated now, then the block is assumed to be occupied. The indicators are used for indication of occupancy.

It may be required, that a train has to stop or to change its speed when passing a certain block. This is for example the case, when the block ahead is not available, when the train will stop inside the block for a certain amount of time or when another speed limit applies in the subsequent block. The exact locations, where trains will stop or change their speed inside the block are determined by marking certain indicators with stop or brake markers.

Stop and Brake Markers

Let us assume that a train approaches a certain block. That means, that none of the assigned indicators was activated before and that at least one of these indicators is activated now. The block is now marked as occupied and the train continues with unchanged speed. If the train reaches a location in the block, which is marked by a brake marker for the current direction of travel (see section 5.3, “”) and the train has to stop inside this block, then the train is decelerated to its threshold speed. The braking ramp can be set as
desired individually for each brake marker. If the train reaches a position, which corre-
sponds to a stop marker for the current direction of travel and the train has to stop inside
this block, then the train is stopped here.

A stop marker determines a point in a block, where trains stop. Stop markers are repre-
sented in TrainController™ Bronze by red arrowheads pointing to the direction of
travel, in which they apply. A brake marker determines a point in a block, where trains,
that have to stop in a block, begin to slow down. Brake markers are represented in
TrainController™ Bronze by yellow arrowheads.

Diagram 88: How Brake and Stop Markers work – Occupancy Sensors

Diagram 88 shows a block, which is equipped with three occupancy sensors. The left en-
tries to the sensed track sections are labeled with B1, B2 and B3.
An alternative, but for this discussion almost equivalent situation is shown in Diagram 89. It contains a block equipped with momentary contacts. These contacts are labeled with B1, B2 and B3, too.

B3 is marked with a stop marker (▶️) effective for trains travelling to the right. B2 is marked with a brake marker (▷️) effective in the same direction. B1, which applies only to the first diagram, is neither marked as brake nor as stop marker. B1 is used only for occupancy detection.

The red line shows the speed of the train. It is assumed that the train will stop in this block, at B3. When the train enters the block at B1 nothing happens, because B1 is only used to report the entry into the block. When the train reaches B2, it is decelerated to its threshold speed. The braking ramp can be specified individually for each brake marker. After deceleration the train proceeds at threshold speed until it reaches B3. When the train reaches B3, it is stopped immediately.

Diagram 87 shows the same situation as Diagram 88 configured in the block editor.

If the train does not have to stop in this block, then it passes all indicators and markers without any speed change.

If the stop marker B3 is missing, then the train will run with normal speed to B2, slow down according to the specified ramp and stop. If no stop marker is assigned to a block, then the first appropriate brake marker is used as stop marker. If B1 is the only indicator and there are no markers in the block, then the train will be stopped immediately at B1.
If no marker is assigned to a block, then the first triggered indicator implicitly defines a stop marker. If necessary, a train is stopped in a block anyway, even if only indicators and no brake and stop markers are assigned.

**This example also illustrates that proper operation of brake markers requires correct adjustment of threshold speed of each affected train! If this is not the case, the train will be decelerated to an undefined threshold speed. Normally this speed will be too low to run the train properly and the train may stop before reaching the stop marker.**

A stop or brake marker is always associated with an indicator. Usually this is a contact indicator, that represents an occupancy section or momentary contact installed on your layout. A stop or brake marker is valid for a particular direction of travel. The marker usually takes effect, when a train running in this direction enters the associated occupancy section or touches the associated momentary contact.

While each marker is always associated with exactly one indicator, it is possible to use the same indicator with several markers. The same occupancy section, for example, can be used to slow down passing trains (brake marker) and to stop trains in a certain distance behind the border of the section (shifted stop marker). This is accomplished by adding a brake and a stop marker to the same contact indicator, which represents the occupancy section, and by specifying an appropriate ramp for the brake marker.

**Please note that a brake marker is only effective if the train has to stop in the same block. As a consequence brake and stop markers that belong together must be contained in the same block.**

The same indicator can be marked with stop or brake markers for one or both directions of travel. It is even possible, that a certain indicator is associated with a stop marker in one direction and with a brake marker in the opposite direction.

It is recommended that the sensors corresponding to stop markers are located at positions, which ensure, that even long trains completely fit into the block.

If an engine or train passes a sequence of blocks and a certain block is not available or must be passed at restricted speed, then the train is stopped or decelerated in the previous block. Brake and stop markers control, if a train may exit a certain block. For this reason **TrainController™ Bronze** always assumes, that stop markers are usually located near the exit of each block with reference to the direction of travel in which they are effective.
When a train enters a block, the dispatcher checks if there is a route before the next block. In this case, the route is activated if this has not already been done. If the activation is not completed when the train reaches the brake or stop marker in this block then the train is decelerated or stopped, respectively, in order to wait for the activation of the route. If there is only one indicator without any markers in this block, then the same indicator is used for indication of entry into the block, activation of the route and also implicitly as stop marker. In this case, the train is always stopped briefly because the activation of a route takes some time.

To avoid such stops it is important to use different locations in the block for brake and stop markers.

TrainController™ Bronze assumes that a train ready to be started is located with its head near the exit of its current block. It is also assumed that the train will exit its current block and enter the next block just after being started. For this reason any speed conditions of the first block are ignored and the train is accelerated to the speed, which applies in the second block.

All speed changes take place at the appropriate markers of the previous block.

5.8 Arranging Indicators and Markers in a Block

This section describes the different types of sensors and how to use them to operate a block.

Arranging Momentary Track Contacts and Occupancy Sensors in a Block

In the following it is assumed that the track section between the turnouts in the following diagrams is a block. Several methods of arranging indicators and markers in a block are discussed below. The pros and cons of each method are outlined as well.
Diagram 90 shows a block equipped with three occupancy sensors. Each of these sensors is associated with a contact indicator in the software called A, B and C. All indicators are assigned to the same block in the software. The block is indicated as occupied as soon as a train enters section A from the left or section C from the right. The block remains occupied until the train leaves the opposite section. A stop marker has been defined for indicator A for trains running to the left, C is marked with a stop marker for trains running to the right. The trains are stopped at the boundary between B and A or C, respectively. The indicator B is associated with two brake markers for both directions. Trains begin to slow down when entering B from either direction. The sections A and C should be long enough such that each train is safely stopped before touching one of the turnouts. On the other side the longest train should completely fit into the block when being stopped. For this reason the boundaries between B and A or C, respectively, where trains are stopped, must be located close enough to the boundaries of the complete block.

The configuration displayed in Diagram 90 is the optimal and recommended solution. The block is indicated as occupied as long as a train is located in one of the three occupancy sections. Additionally it would be even possible to distinguish in which of the three sections A, B or C a train is located. Lost or parked cars can be detected, too, if they cause an occupancy indication. Pushed trains can also be treated, too, if the first pushed car generates an occupancy indication. This method requires the effort, however, of cutting the rails at the boundaries of each occupancy section.

Diagram 91: Block with an occupancy and two momentary sensors

Diagram 91 shows a block equipped with one occupancy (B) and two momentary sensors (A and C). Each of these sensors is associated with a contact indicator in the software called A, B and C. All indicators are assigned to the same block in the software. The block is indicated as occupied as soon as a train enters section B from any direction. The block remains occupied until the train leaves section B. The indicator A additionally corresponds to a stop marker for trains running to the left, C is marked with a stop marker for trains running to the right. Both indicators are additionally marked with brake markers for the opposite direction, respectively. The location of A and C should ensure, that each train is safely stopped before touching one of the turnouts. On the other side
the longest train should completely fit into the block when being stopped. For this reason A or C, respectively, where trains are stopped, must be located close enough to the boundaries of the complete block.

Application of Diagram 91 has take into account, that momentary contacts tend to be less reliable than occupancy sensors.

Diagram 92: Simple Block with two momentary sensors

Diagram 92 shows a simple configuration of a block equipped with two momentary sensors. Both sensors are associated with a contact indicator in the software called A and C. Both indicators are assigned to the same block in the software. The indicator A is additionally marked with a stop marker for trains running to the left, C is associated with a stop marker for trains running to the right. Both indicators are additionally marked with brake markers for the opposite direction, respectively. The location of A and C should ensure, that each train is safely stopped before touching one of the turnouts. On the other side the longest train should completely fit into the block when being stopped. For this reason A or C, respectively, where trains are stopped, must be located close enough to the boundaries of the complete block.

The configuration displayed in Diagram 92 is very simple and inexpensive but has also some disadvantages. Block occupancy is not indicated. As long as the block is reserved for a train located inside this block this causes no major problem, because the dispatcher will not allow another train to enter this block. But certain measures are to be taken to avoid premature reservation of this block for another train when a train leaves the block. There is also a disadvantage for passing trains. Let us assume that a train is passing the block from the left to the right and that a route is to be activated before the block ahead, to the right of this block. As soon as the passing train enters the block at A the route is activated. In the same moment the train begins to slow down, because A defines also a brake marker and the train has to wait, until the route is reported to be activated which takes time. This could be avoided by adding an additional contact as shown in the following diagram:
Diagram 93: Block with three momentary sensors

In Diagram 93 the indicator A defines a stop marker for trains running to the left, C acts as stop marker for trains running to the right. Indicator B is marked with brake markers for trains running in both directions. In this configuration block occupancy is not indicated, too, and as in Diagram 92 certain measures are to be taken to avoid premature reservation of this block for another train when a train leaves this block. But trains can pass this block without any speed changes, even if there is a route to be activated before the block ahead – provided the distance between A and B or C and B, respectively, is large enough such that the route can be activated after passing A or C, respectively, and before reaching B.

All examples discussed so far can be applied for blocks passed by trains in both directions. The configuration can be made simpler if trains pass a block only in one direction. This is shown in the following:

Diagram 94: Block with two occupancy sensors

Diagram 94 has been derived from Diagram 90 by eliminating sensor A. It is assumed that the block is only passed from the left to the right. B acts as brake marker and C as stop marker for trains running to the right.

The different configurations discussed in this section are only examples. Configurations similar to Diagram 94 can also be made with momentary contacts instead of occupancy sensors or with a mixture of both types similar to Diagram 91. One can think also of other configurations. There is no best way to setup a block. The optimal solution does
not only depend on technical requirements but also which equipment you already have and how much money you want to spend on new equipment.

**One Sensor per Block: Shifted Stop Markers**

In the examples discussed so far, all locations, where trains stop are identical to the entry of an occupancy section or to the point, where a momentary track contact is triggered. In Diagram 93 we even installed an extra sensor to isolate the location, where the entrance into the block is reported, from the location, where the train begins to brake to gain time for activation of subsequent routes.

But it is not essential to install extra sensors for this purpose. It is also possible, that a stop marker is located in a certain distance from the point, where the associated sensor is turned on. This is done by assigning a brake and a stop marker to the same indicator and by specifying a ramp for the brake marker. This creates a *shifted stop marker*.

If your trains run very precisely and the simplified speed profile has been adjusted accordingly, then it is not necessary to install a separate sensor to mark the stop point C. Instead it is possible to mark the occupancy sensor B with a brake marker and a shifted stop marker for stop point C.

Assume that in the above example the desired stop point C is located in a certain distance from the left border of the occupancy section B. If it is desired, that trains decelerate and stop in a certain distance after entrance into B, then contact B is marked with a brake marker and a (shifted) stop marker. For the brake marker an according ramp is additionally specified to accomplish smooth deceleration and to adjust the location approximately, where the train stops.
If a train, that has to stop in this block, enters the occupancy section B from the left, it will be decelerated to threshold speed within the specified ramp. When it arrives at the point C, which is determined by the ramp, the train will be stopped automatically.

In other words: the shifted stop marker associated with B works exactly like an additional sensor marked with a stop marker located in a certain distance behind the entrance into section B.

This principle can also be applied to the opposite direction. In this way one single occupancy sensor (sensor B in this example) can be marked with brake markers and shifted stop markers for both directions. For reasons of simplicity the markers for the opposite direction have been omitted in Diagram 95.

Diagram 96 demonstrates, how brake and shifted stop markers are arranged for both directions in the block editor. Trains, that will stop in this block, will begin to slow down at the entrance of the occupancy section. The braking ramp will cause these trains to decelerate to threshold speed and stop within a certain distance behind the entrance.
The complete configuration displayed above can be created with the block editor for both directions in no time at all with a few mouse clicks.

Brake and shifted stop markers allow operation of a complete block with one single sensor and indicator symbol.

5.9 Block Signals

General

Traffic Blocking is used on real railroads to prevent two trains from running into each other by dividing the track into sections protected by signals. These signals (here called block signals) indicate to a train whether it can enter the block which begins beyond the signal. If the block ahead is occupied the driver of a train approaching the signal protecting that block sees a red stop light. If the section in front is unoccupied and the train has permission to enter it the driver sees a green signal light. In addition to the signal for the next block the driver is usually also presented with an advance signal which indicates the status of the block beyond that which is being entered. If the advance signal indicates green, it means that the subsequent block is free to be entered; otherwise the block ahead is occupied and the train should proceed into the next block with caution and be prepared to stop at a red light.

When a train is running under control of the Dispatcher, TrainController™ Bronze automatically calculates signal aspects taking into account the availability of blocks and routes in front of the train. These signal aspects are displayed in the block diagram. The signals indicate, whether the current block may be left and how the following block must be entered. The brake and stop indicators assigned to a block ensure that a train is stopped at the appropriate location. Since TrainController™ Bronze assumes that the brake and stop indicators belonging to a block are located near the exit of the block, this is also assumed for the imaginary location of block signals.

TrainController™ Bronze displays the signal aspect currently valid for a block, when the first indicator assigned to this block is reached. It is possible to say: “The engineer is able to see the block signal at the end of a block when the train enters the block”.

Signal Aspects

TrainController™ Bronze uses four different signal aspects - each is associated with a specific color:
<table>
<thead>
<tr>
<th>Color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Stop</td>
</tr>
<tr>
<td>Green</td>
<td>Proceed</td>
</tr>
<tr>
<td>Yellow</td>
<td>Proceed Restricted</td>
</tr>
<tr>
<td>Grey</td>
<td>Signal not available</td>
</tr>
</tbody>
</table>

**Table 2: Signal Aspects**

For each train under its control the *Dispatcher* calculates the aspect of the next block signal and the advance signal. The signal aspect is calculated depending how the train is operated.

When a train is executing a schedule the availability of the next two blocks in front of the *current block* of the train is calculated as home and as advance signal. If the train must not enter the block, then the signal of the previous block is set to “red”. If the train may enter the block, then the signal is set to “green”. If the block is available and reserved for traveling with restricted speed, then the signal is set to “yellow”.

Similarly the same signal aspects are valid for the *advance signal*, which indicates in advance, whether the train is allowed to leave the block behind the *current block* and how the next block behind this advance block must be entered.

“Grey” is used, if the other colors do not apply. This is also the case, if the train is not running under control of the *Dispatcher*.

The calculated state of the home signal of each block is displayed on the relevant side in the symbol of the block.

![Diagram 97: Block Signals](image)

In the example displayed above a train may leave “Southtown 1” and proceed to “Main Line East”. The signal symbol on the right side of the block shows green. The signal on the other side displays red, because it is assumed that the train must not enter “Main Line West”.
TrainController™ Bronze does not need any signals on your model railroad to control trains. But for realistic operation it should be possible to indicate the calculated signal aspects with appropriate signal models on your model railroad. For this purpose it is possible to create two signals within each block, one for each direction of travel. These signals are called integrated block signals. Integrated signals can be linked to physical signal models on your layout. They are automatically operated according to the calculated signal aspects of the block they belong to.

These signals are only used for indication. They do not need any facilities to control trains, because the trains are controlled by the Dispatcher.

It does also not matter, if the used signal models represent home or advance signals, because the models are only used for display. Selecting the appropriate signal model and location you are free to decide, where home and where advance signals will be visible. These signal models are of course operated dependent on the direction of travel. For this reason you can create a signal for each direction of travel.

How Block Signals Work

The following example shows for blocks A to D, which are subsequently passed by two trains.

Diagram 98: Block Signals

The internally calculated signal aspects are indicated inside the black rectangles below the block name. Above the track there are signal elements controlled according to these aspects. For example the block signal labeled “B” is assumed to belong to block B.

Train 1 may enter block B but not block C, because block C is still reserved and occupied by train 2.
The calculated block signal for train 1 in block A is green, because train 1 may leave block A and enter block B without any restrictions. This is also indicated by signal A, which is assumed to belong to block A.

Since train 1 must not enter block C, the block signal of block B is calculated as red. This state is indicated by signal B of block B.

Train 2 may leave block C and enter block D only with restricted speed. For this reason the calculated block signal for train 2 in block C is yellow. This state is indicated by signal C, that belongs to block C.

**Additional Notes**

The internal signaling system of TrainController™ Bronze does not claim to simulate realistic signaling systems of the prototype. For each block the software only calculates, whether a train may leave this block in the related direction and whether any speed restrictions apply. This calculation is only done for those blocks, that are currently in the focus of an active schedule.

By linking integrated block signals to signal models on your layout the internally calculated aspects can be made visible on the layout if desired. This simplified signaling system is easily arranged and meets the requirements of playful model railroad operation.

5.10 Spontaneous Runs

After arranging the block system in TrainController™ Bronze as outlined in the previous sections it is possible to run trains under full protection and routing of the computer. Put a locomotive on the track, assign its symbol to the associated block and call the menu command Spontaneous Run. The train will immediately start to move, provided that the route ahead is clear. It will then select an appropriate path and continue to travel, until it reaches a dead end or until the path ahead is blocked for another reason. At a dead end or if the train could not proceed for a certain time for another reason it will reverse automatically, if desired, and continue to travel in the opposite direction.

With this method routes can be treated in different manners. It is either possible to allow the computer to select and activate all routes requested by the train automatically. It is also possible to leave this to the human operator. In this case the train is stopped in blocks with at least one outgoing route, until one of these outgoing routes is selected and activated by the human operator.
If no further measures are taken, trains may run anywhere on your layout. Another way to control the path each train takes is the definition of schedules. This is outlined in the following section.

### 5.11 Schedules

**Schedule Diagrams**

After drawing your block diagram you will specify the desired train movements. This is done with the help of *schedules*.

Schedules describe how trains travel from selected starting blocks to destination blocks.

The base of each schedule is a *schedule diagram*. This diagram contains all blocks and routes of the main block diagram, that the train will use on its journey. This diagram can be displayed on the computer screen, too. This is done by displaying those parts of the main block diagram, that do not belong to the schedule, transparently in the background of the computer screen as shown below:
Diagram 99 shows the diagram of a schedule, that starts in “Hidden Yard 3”, passes “Mainline East” and ends in “Southtown 1”. The blocks and routes, that belong to this schedule, are drawn with normal intensity, while the objects, that do not belong to the schedule are drawn transparently in the background. In a specific mode of the software you can easily pick and add them to the current schedule with a click of the mouse on these objects.

Additionally one or more starting blocks and optionally one or more destination blocks are to be specified. Starting blocks are marked in the schedule diagram with a small green marking, destination blocks with an orange or red marking. In the diagram above “Hidden Yard 3” is marked as a starting block and “Southtown 1” is marked as a destination block.

In order to start this schedule, assign an arbitrary train to block “Hidden Yard 3”, select the schedule on the computer screen and call the appropriate start command of TrainController™ Bronze. The Visual Dispatcher will automatically allocate the blocks and activate the routes, that belong to this schedule and will automatically start the train. When the train reaches the stop indicator in “Southtown 1”, the schedule is terminated.
A schedule can only contain elements, that are also contained in the main block diagram. The location of each element in the display is determined by the location of the referenced element in the main block diagram. If an element in the main block diagram is changed, moved or deleted then this change is reflected in all schedule diagrams. In this way multiple schedules can be conveniently maintained by changes to the main block diagram.

Start and Destination of a Schedule

Each schedule contains one or more start blocks and one or more destination blocks. Start blocks are marked in the schedule diagram with a small green marking, destination blocks with an orange marking.

**It is required that you mark the desired start and destination blocks otherwise the schedule cannot be started.**

In Diagram 99 “Hidden Yard 3” is marked as start block to the right and “Southtown 1” is marked as destination block to the left.

Start, destination and other schedule specific section settings are entered in the dialog box displayed below.
Passage through each Block

The direction, in which blocks are passed by trains running from a start to a destination block of the schedule is marked with grey and highlighted color at the exits of each block. Trains on this schedule pass each block from the grey to the highlighted exit. A train running the schedule in Diagram 99 from “Hidden Yard 3” to “Southtown 1” will pass “Main Line East”, for example, from the grey exit at the top to the highlighted exit at the bottom. Blocks, that are passed in both directions in the same schedule, are displayed with both exits highlighted. Blocks, that are not included in the schedule or that cannot be reached by a train executing this schedule, are drawn with two grey exits. If a block, that is included into your schedule, is drawn with two grey exits, then no path exists from a starting block to a destination block, that touches this block.

Note that schedules can also be started to the opposite direction, i.e. from a destination block to a starting block. In such case each block is passed from the highlighted to the grey exit.
Alternative Paths

One of the most outstanding features of the Visual Dispatcher is the ease of specifying alternatives for the path a train has to take when executing a schedule.

Diagram 101: Schedule Diagram with alternative Paths

Diagram 101 shows a schedule for train movements, that begin in of the three blocks in “Hidden Yard”, proceed on the mainline in a clockwise direction, pass “Souhtown” through one of the two blocks and end again in “HiddenYard”.

To start the schedule, assign a train to one of the blocks in “Hidden Yard”, select the schedule on the computer screen and call the appropriate start command of TrainController™ Bronze. The Dispatcher will automatically allocate the blocks and activate the routes that belong to this schedule and will automatically start the train. If there is more than one train located in “Hidden Yard” and both can be used with this schedule, one of the trains will be selected automatically. It is also possible for you to pre-select the train before starting the schedule.

The Dispatcher will also look for an appropriate path through “Souhtown” and will select a block in “Souhtown” as well as appropriate routes to this block, that are available. If both blocks of “Souhtown” are currently available, then the Dispatcher will perform a
random selection. In the same way an appropriate block in “Hidden Yard” is selected, when the train approaches the destination.

Further, each schedule can be started in either direction. If the schedule is started in the opposite direction, then the specified destination blocks of the schedule are used as starting blocks and the starting blocks become destination blocks. The schedule of Diagram 101 can also be started in the counter-clockwise direction.

Since the start and destination blocks are identical in this example the trains will start and end in “Hidden Yard”. In Diagram 99, though, a train will start in “Hidden Yard 3” and end in “Southtown 1”, if the schedule is started in the normal direction. Starting the same schedule in the opposite direction will cause these two blocks to swap their meaning. “Southtown 1” will become the starting block and the train will end in “Hidden Yard 3”.

The terms start and destination are mainly used to describe, from where to where the trains travel on this schedule and where trains end. The actual starting block of a train can also be located in the inside of the schedule. In Diagram 101 the Dispatcher will first try to find an available train in “Hidden Yard”. If there is no appropriate train in “Hidden Yard” the Dispatcher can be instructed to start a waiting train in “Southtown”, if desired. If you select a waiting train in “Southtown” and start a schedule with that train, the Dispatcher will use this train, even though it is not located in the starting block of the schedule.

The destination blocks are always used as the end point of each schedule. In other words: a train can be started in any block of the schedule and it will always make its way to an appropriate destination block, that can be reached from where it is started.

Looking at Diagram 101 we realize, that with one single schedule diagram and by picking a few blocks and routes from the main block diagram, we can describe all possible train movements in both directions on the main line of this layout.

- The start and destination blocks of each schedule are to be specified manually.
- It would for example be possible to explicitly specify “Southtown 1” as an additional destination block in Diagram 101. If Southtown 1 is available, then each train coming from “Main Line East” will select “Southtown 1” as its destination. If “Southtown 1” is not available, the train will automatically proceed via “Southtown 2” to “Hidden Yard”.
- It is not possible to reverse a train within a schedule. If, for example, a train enters “Southtown 1” from “Main Line West” it is not possible to leave “Southtown 1 to “Main Line West” without first terminating the current schedule and starting another
schedule. This other schedule can, however, be another run of the same schedule diagram.

- It is not possible to change a train within a schedule.

Schedules describe train movements of one train from blocks to other blocks without changes of trains and without changes of direction.

You can create as many schedules as you need.

Schedules are not bound to specific trains. In principle, each schedule can be executed by any train. In this way, by specifying only a few schedules it is possible to achieve varied operation for many different trains. To start a schedule with a specific train, the train must, however, be currently located in a block of this schedule.

To run your trains with realistic speed it is very important that the speed profile of each affected engine is set (see section 3.5, “The Simplified Speed Profile”).

5.12 Execution of Schedules

For varied operation or special situations you can specify among others the following attributes for each schedule:

- If the schedule will be executed manually or automatically controlled by the computer.
- A time period for which the Dispatcher repeatedly tries to start the schedule, if the first attempt to start the schedule fails.
- Whether certain blocks or routes of the schedule will be passed with restricted speed.
- Whether and how often the schedule will be repeated as a cycle or by a shuttle train.
- A selection of other schedules, which are started after finishing the schedule with regard to availability

Starting a Schedule

Each schedule can be started during operation of the layout in either of the two possible directions, i.e. from the starting to the destination blocks or vice versa.

When a schedule is started, the Dispatcher searches the starting (destination) blocks of the schedule until it finds a current block of a train, which is not already running on another schedule.
If no train is found on a block of the schedule or all trains are already running other schedules then the start of the schedule fails. It is possible to specify a time period for which the Dispatcher repeatedly tries to start the schedule, if the first attempt to start the schedule fails.

A schedule is always started with one train. If you want to start the same schedule with several trains, then the start of the schedule must be executed several times according to the number of trains to be started.

Reservation of Blocks and Routes

When a train is started on a schedule, the Dispatcher tries to reserve at least the current block and the next block in front of the train. Also, when a train enters a block, the block ahead is reserved.

In the situation displayed above the train has just entered block “Main Line East” (displayed in red). The block ahead is reserved for the train.
The route located between the current block and the block ahead is activated, too. A route is assumed to be located between two blocks, if it connects these blocks in the schedule diagram.

If it is not possible to reserve at least one block ahead of the train or if the route to this block cannot be activated, then the signal at the related block exit is set to red and the train must not proceed.

When a block directly ahead of the train is about to be reserved, then the Dispatcher checks, whether there is a route ahead of the block ahead. If this is the case, then this route and the block ahead of this route are reserved. This is done to reserve and activate the route in time to prevent unintentional train stops caused by long lasting route activation.

The diagram displayed above demonstrates this. On entry into block “Main Line East” the Dispatcher does not only reserve block “Southtown 2” at the bottom. The Dispatcher also checks, whether there is a route directly ahead of “Southtown 2”. Since this is the case, this route and the block ahead of this route are reserved, too. This is done to avoid unintentional train stops in “Southtown 2” due to the fact, that the train must not leave “Southtown 2” before the route to “Main Line West” is activated.

What happens, if “Main Line West” is currently not available in this situation? This is no problem. The Dispatcher only tries to reserve the additional route and the block ahead of “Southtown 2”. If this is currently not possible, then the train is allowed to simply proceed to “Southtown 2”.

Path Selection

The Dispatcher follows a smart strategy, when it has to select one of several possible paths. In Diagram 101, for example, the Dispatcher has to select one of three possible paths, when a train approaches the “Hidden Yard” from the west or from the east.

In the following the criteria which influence the selection of a path are listed. The following aspects lower the chance of a path being used or prevent a path from being selected at all:

- Other trains, that reserve one or more blocks and routes ahead of the train.
- Locks applied to the entry or exit of certain blocks (see page 110).
- Blocks or routes, that are reported as occupied by unknown objects.
- The distance to an appropriate destination block.
- Superfluous loops.
There are also criteria, that raise the chance of a certain path being selected:

- Activated routes ahead of the train, that are not reserved by other trains.
- The distance to the nearest obstacle listed in the previous list.

At first the Dispatcher evaluates each possible path according to the criteria listed above. Two paths are equivalent with regard to these criteria, if exactly the same aspects apply. If two paths are equivalent, then the Dispatcher performs a random selection.

**The criteria listed above do not prevent a path from being selected. They lower the chance of a path to be selected, though, but the Dispatcher might select a path, which is affected by a negative criterion, if there is no “better” alternative.**

Special attention should be paid to the distance to an appropriate destination block. If the distances to appropriate destination blocks of two alternative paths are different, then the Dispatcher will probably select the shorter path. If the shorter path is currently locked by an obstacle, then it depends on the difference of these distances, whether the Dispatcher uses the longer path or decides to try to pass through the shorter path in the hope, that the obstacle soon disappears. In other words: the Dispatcher does not select a free path under all circumstances, especially not, if the free path is much longer than other alternatives, that are currently not available.

**Release of Blocks and Routes**

In general a block or route reserved by a schedule is released when the train has reached a block ahead of this block/route and when this block/route is not indicated as occupied anymore. In Diagram 101, for example, block “Main Line East” is not released before a train coming from “Hidden Yard” has reached “Southtown”. If “Main Line East” is still indicated as occupied when the train reaches “Southtown” release of “Main Line East” is further delayed until the occupancy indication of “Main Line East” is turned off.

In detail the following rules apply:

- A block is assumed to be reached, when the train reaches a stop indicator assigned to this block.
- An occupied block or route is not released. (An exception of this rule is outlined below.)
- A block or route is not released until the train has reached a block behind of this block/route.
• When a train reaches a block all non-occupied blocks/routes located before this block, but not located behind another occupied and reserved block/route, are released. If, for example, “Main Line East” in Diagram 101 is still reserved and occupied when the train reaches “Main Line West”, then the used block of “Southtown” is not released, regardless whether it is occupied or not. If both, “Main Line East” and the related block in “Southtown”, are unoccupied when the train reaches “Main Line West”, then both blocks are released.

• When the train reaches the destination position of the current schedule, i.e. the stop indicator in a destination block of this schedule, then all blocks and routes apart from this last block are released, regardless whether they are currently occupied or not.

Preset Block Signals and Speed Limits

As outlined in section 5.9, “Block Signals” TrainController™ Bronze automatically calculates signal aspects for all trains running under control of the Dispatcher. These signal aspects take into account the availability of blocks and routes ahead of the train. If the train must not enter a block, then the signal of the previous block is set to “red”. If the train can enter the block, then the signal is usually set to “green”. It is additionally possible, however, to cause TrainController™ Bronze to display “yellow” instead of “green”, if desired.

For this purpose it is possible to select an individual signal aspect (yellow or green) for each block or each route in a schedule. Dependent on this setting TrainController™ Bronze will automatically apply the selected color to the calculated block signal, if the train may proceed.

These signal settings are specified at the level of blocks and routes in a schedule. That means: the same block or route may have differing signal settings in different schedules.

If the signal for a block in schedule “A” is set to green, then the train will pass this block at maximum allowed speed, when schedule “A” is executed. If the signal for this block in schedule “B” is set to yellow, then the train will pass this block at limited speed, when schedule “B” is executed.

The speed limits for the green and yellow signal are hard coded in the software and cannot be changed.

Waiting Time

You can specify a waiting time for each block contained in a schedule in order to perform scheduled stops in certain blocks of a schedule.
Additional Operations

Finally it is possible, to assign operations to each block of a schedule in order to turn on or off an *engine function* (see section 3.6, “Headlights, Steam and Whistle”).

These operations can optionally be performed when

- the train enters the block
- the train reaching a brake indicator has to reduce its speed
- the train has to stop
- the train starts again after a stop
- the block is released after the train has left the section

Additionally it is possible to perform operations before starting or after finishing the schedule.

![Diagram 103: Specifications of the Section of a Schedule](image)
In the example displayed above each train entering the related block will turn on the light. Additionally it will blow its whistle when the block is released later.

If a function symbol specified here is not configured for an engine, then this engine will do nothing, when it executes this schedule. If, for example, the function symbol *Whistle* is only assigned to steam engines in the example displayed above, then diesel engines will remain quiet when executing this schedule.

These operations are specified on a per-schedule base. It is possible to specify different operations for different schedules.

**Type of a Schedule - Shuttle and Cycle Trains**

There are different types of schedules.

Normally – when no special type is selected – the journey of the train ends in a destination block of the schedule.

If a train will repeat the schedule as a *shuttle train*, it will be started again after arriving in a destination block and will run back in the opposite direction to an appropriate start block. It is possible to specify a repeat count to control, how often the schedule will be repeated.

It is also possible to repeat the schedule as a *cycle* based on a circular diagram. In this case the train is started again on the same schedule after arriving at the destination block of the schedule. The train repeats traveling on the schedule in the same direction as before. As for shuttle trains it is possible, to specify how many times the cycle will be repeated.

When repeating schedules as a cycle it is necessary that these schedules are circular, i.e. destination blocks must also be start blocks.

**Running Trains manually under Control of a Schedule**

For each schedule you can specify its *driving mode*. If desired you can control engines and trains on the schedule completely manually. In this case the computer reserves the blocks, activates the routes and calculates the block signals. You are – like a real engineer – responsible for obeying the indicated signals and following the speed conditions. But it is also possible to transfer the control over the schedule completely to the computer. In this case all engines and trains on this schedule are operated automatically. Finally it is also possible to share the engineer's job with the computer. In this way it is for
example possible, that the train is running under your manual control, but that the computer is able to intervene to stop a train in front of a red signal.

<table>
<thead>
<tr>
<th>Driving Mode</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Trains are completely controlled by the computer</td>
</tr>
<tr>
<td>![Icon]</td>
<td>The computer intervenes when restricted speed is prescribed or when the train approaches a red signal requesting the train to stop.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>The computer intervenes, when the train approaches a signal requesting the train to stop.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Trains are almost completely controlled manually. If the human operator fails to stop the train in time before reaching the stop marker in front of a red signal, then the computer performs an emergency stop of the train.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Trains are completely controlled manually.</td>
</tr>
</tbody>
</table>

**Table 3: Driving Modes of a Schedule**

It is possible to use different modes for different schedules, regardless whether these schedules share the same blocks and routes or not. This enables full automatic operation of one part of your layout and running trains manually under computer control in another part.

Different schedules with different modes can be arranged for the same part of your layout, too. It is for example possible to create two schedules for the main track of your layout. The first schedule is used for automatically running trains, while the second schedule uses the same track for trains operated manually under control of the computer. In this way you can operate your favorite train manually while other trains in front of or behind this train are controlled automatically.

Driving modes can also be specified individually for each particular engine. This mode is applied to the engine in spontaneous runs (see section 5.10, “Spontaneous Runs”).

5.13 **AutoTrain – Start of Schedules made Easy**

**AutoTrain™** is another outstanding feature of **TrainController™ Bronze**. With **AutoTrain™** you can run automatic trains at any time during operation without the need to define schedules in advance.

**AutoTrain™** is especially useful in the following cases:
• If a train will automatically run somewhere during operation and you did not specify an appropriate schedule to perform this task in advance.
• If you want to define a new schedule quickly from scratch.

Auto Train by Drag & Drop

The fastest way to run AutoTrain™ is Drag & Drop with the mouse:

• Open the Schedule menu and call the AutoTrain by Drag and Drop command (alternatively press and hold the key ‘A’ on your computer keyboard; A = AutoTrain™).
• Press the left mouse button near the exit of the block in the block diagram or in the switchboard, where the train will start.
• Hold the left mouse button pressed and drag the mouse to the exit of the block in the block diagram or in the switchboard, where the train will stop.
• Release the left mouse button (and the ‘A’ key, if necessary).
• The train will now start and run automatically to the destination block.

Auto Train Toolbar

With the AutoTrain™ toolbar you have more options for individual customization before the train is actually started. To run a train with the AutoTrain™ toolbar the following steps are performed:

• Open the AutoTrain™ toolbar.
• Select the locations (blocks) on the layout, where the train will start.
• Select the locations (blocks) on the layout, where the train will stop.
• Optionally specify additional options that influence the execution of the AutoTrain™, such as waiting time, operations, cycle, shuttle, etc.
• Start AutoTrain™.

Diagram 104: AutoTrain Tool Bar

After starting AutoTrain™ automatically tries to find a path from the specified start block to the specified destination blocks. If a train is located in the start block, it is automatically started to run in the selected direction.
A started AutoTrain™ is very similar to a schedule which is currently executed. It has one starting block and one or more destination blocks, that are selected before AutoTrain™ is started.

There are some additional options:

- After selection of the start and destination blocks you can let AutoTrain™ try to find a path from the start to the destination blocks without starting a train. This is useful in edit mode, especially if no train is located in the start block. This is also useful if you want to check the resulting path before actually starting the train. Together with another option, that allows you to store the current AutoTrain™ as a permanent schedule for later use, this is a very fast method to create new schedules by letting the software calculate the appropriate paths for you.
- It is possible to select certain blocks or routes to be included in the schedule prior to starting the search for an appropriate path. Each path found will then pass through these blocks or routes, if possible. This gives you more control over the resulting path.
- It is also possible to exclude certain blocks or routes from AutoTrain™ prior to starting the search for an appropriate path. This also gives you additional control over the resulting path.
- You can also specify, whether only the shortest possible paths from the start to the destination blocks will be taken into account or all possible paths.
- Additionally it is possible to limit the search time. This option is useful in the case of large or complex layouts and slow computers, where the search may take a while.

While an AutoTrain™ is active you can also store it as a schedule to execute it later, e.g. as part of a time table.

AutoTrain™ requires the prior calculation of a block diagram.

With regard to selection of blocks and routes AutoTrain™ follows the same policies, that are valid for schedules. That means: as well as allowing you to include blocks or routes, which are currently locked, into a schedule in edit mode, AutoTrain™ also includes blocks or routes, which are currently unavailable. In this way it is possible to create schedules with AutoTrain™ for later use, which contain blocks or routes, that are currently not available.
5.14 Successors of a Schedule

For each schedule it is possible to specify a set of successor schedules, one of which will be started after the schedule is finished.

Several options allow you to specify how control of the train is passed from a schedule to its successor:

- You can select to keep the train, i.e. to enforce that the successor continues with the same train as before, or to enforce a train change.
- It is additionally possible to specify, that the successor schedule will be started with the oldest train. The oldest train is the train, which has not been operated by a schedule for the longest time. TrainController™ Bronze allows you to combine this option with the other options. If this option is combined with the option to perform a train change, then the successor is started with the oldest train, that differs from the previous train. If this option is combined with the specification of a train group, then the oldest train, to which the train group applies, is started.

With schedule successors it is possible to control a hidden yard automatically. A train arriving in a hidden yard can be enabled to select another waiting train, which will leave the hidden yard.

If it is intended to start the successor with the same train, then it is recommended, that the successor starts with a destination block of the previous schedule. In this block the control of the train is transferred to the successor.

If several schedules will be executed in a sequence, e.g. schedule 2 will be executed after schedule 1 and schedule 3 will be executed after schedule 2, then schedule 2 is to be specified as successor of schedule 1 and schedule 3 as successor of schedule 2.

Since it is not possible to reverse a train or to change trains during the execution of a schedule successors must be used if

- a train will be reversed
- trains will be changed

Schedule Successors vs. Long Schedules

Will complex train runs be specified as a chain of schedule successors or as one complex schedule? The answer to this question depends on the individual case and is also a question of personal taste.
A train run, for example, that starts in the hidden yard of the block diagram displayed in Diagram 82, passes both blocks in “Southtown” and ends again in the hidden yard can be specified as a chain of schedule successors or as one big schedule which alternate paths in “Southtown”.

These are the pros and cons of the particular approaches:

**Schedule Successors:**

- Change of train is possible between two subsequent schedules in the chain of successor schedules.
- Static linkage between a schedule and the subsequent schedules in the chain of successors.
- The look ahead to select an optimal path out of several possible alternate paths is limited by the end of the current schedule in the chain. This can improve the performance of the path selection, but may lead to selection of non-optimal paths.
- Chains of schedule successors cannot be started in reverse direction.
- During the change from one schedule to a successor schedule without train change certain minor limitations may apply with regard to calculation of block signal aspects and speed limits due to technical reasons.

**Single long Schedules:**

- Change of train is not possible, until the schedule is terminated.
- The look ahead to select an optimal path out of several possible alternate paths can take into account the complete path to the block, where the train will finally stop. This supports the selection of optimal paths at the expense of program performance.
- Single schedules can be started in reverse direction, i.e. from a destination block to a start block.
- Single schedules can be repeated as cycle or as shuttle train.

**Conclusions:**

- If you want to change the running train between two subsequent schedules, then both schedules must be chained as successors. This is for example useful, if a train entering a hidden yard will trigger another train to leave this yard.
- If the train will not be changed, then it is usually better to create a complex, long schedule rather than a chain of schedule successors.
- If a schedule will be repeated as a cycle or commuter train, then use a single schedule for this purpose.
5.15 Schedule Selections

Sometimes it is desirable to select one of several schedules. This is supported by schedules selections. A schedule selection enables the selection of certain schedules out of a selection of several other schedules. Even though there is schedule diagram associated with a schedule selection such selection can be started like any other normal schedule. It can be used wherever a normal schedule can be used. When a schedule selection is started then one of the schedules contained in the selection is selected and started. This selection may also include other schedule selections.

5.16 Operation Interruption - Termination of Schedules

There are several methods to interrupt the running operation or to terminate schedules. These methods can be accessed by different menu commands. They are described in the following:

- **Global Stop**: This command performs an emergency stop of all connected digital systems and terminates all running schedules. This is the most drastic method to terminate operation and should only be used in very rare, extreme emergency cases. Since all schedules are terminated the computer releases control of all previously running trains. If the emergency stop of the connected digital system is released later, then the software does not have control over any trains.

- **Freeze**: This command performs an emergency stop of all connected digital systems and interrupts all running schedules. This is the recommended method to stop operation in emergency cases. The software keeps control over all previously running trains. After resolving the emergency situation and clearing the freeze state of the software the operation can be continued at the position, where it was interrupted. All previously running trains are automatically restarted.

- **Stop Train**: This command stops the selected train abruptly, but does not terminate any running schedule. It can be used to clear an emergency, where only one single train is affected.

- **Stop All Trains**: This command stops all trains abruptly, but does not terminate any running schedule. All affected trains must be manually set in motion again later.

- **Terminate Schedule / Run**: This command stops the selected train abruptly and terminates its current schedule or spontaneous run, respectively. It can be used to terminate a running schedule prematurely or to stop a spontaneous run.

- **Terminate all Schedules**: This command stops all trains abruptly and terminates their current schedules or spontaneous runs, respectively.
5.17 Putting it all together – The Dispatcher Window

The dispatcher window serves as display for the block system of your layout. It lists and displays all diagrams, blocks, routes and schedules.

![Diagram 105: Dispatcher Window](image)

The dispatcher window is split into two parts. The left part lists the blocks, routes or schedules of your layout. With the particular controls of the page navigator it is quite easy to switch from one view to another. Depending on the selected view additional detail information is also available. The block and route view, for example, additionally provide an optional view of the indicators and markers contained in the currently selected block or route. The schedule view provides optional lists of the blocks and routes contained in a selected schedule and also allows you to display a view of all indicators and markers, that are contained in a certain block or route of this schedule.

The optional indicator view furthermore provide another interesting feature: in offline mode, i.e. if the indicator symbols in the view are currently not connected to an actual digital system, it is possible to turn the status of these symbols on and off by clicking on them with the left mouse button. In this way the sensor events generated by passing trains can be conveniently simulated.
The right part of the dispatcher window displays the currently selected block or schedule diagram. It is possible to switch from one diagram to another by using the diagram selector menu in the upper right corner of the dispatcher window. Click on the name of the current diagram, which is displayed by well visible letters in the upper right corner of the dispatcher window to open the menu of available diagrams and to change to another diagram.

All routes displayed in the dispatcher window, whether displayed in the route list or in the block diagram, can be operated with mouse click, too, when edit mode is turned off.

5.18 Customizing the Dispatcher Window

General

The dispatcher window can be freely resized and zoomed. This allows you to let the display fit the dimensions of the displayed block diagram optimally.

The colors of the window background, blocks and connecting routes can be adjusted to personal taste, too.

The display of block signals and train images can be turned on or off.

Additionally to these general customization features, which were also available in previous versions of the software, TrainController™ Bronze provides the following additional customization features:

- A new option allows the reset of all display options to factory defaults.
- Active routes can be displayed with individually specified colors (as in previous versions), or with the color of the reserving train, if any, or with a color, that is common for all active routes.
- The display intensity of blocks and routes, that do not belong to the currently selected schedule can be dimmed to fit personal taste and to support low contrast display environments.
6 The Traffic Control

During operation of a layout the Traffic Control shows the status of the currently selected train, block or route and the current status of the indicators, that have been assigned to the current object.

Diagram 106: Traffic Control

Here all important information about the currently selected train and its current location is assembled. When you select a train on the computer screen, this train and the block, where it is located, are displayed. When you select a block or a route, this block/route and the train, which is currently there, if any, are displayed.

The speed of the train is made visible with a colored rectangle. The status of the block, whether occupied or not, and the status of the block signals on both exits are displayed as well.

Additionally the indicators and markers, that have been assigned to the block or to the route, are displayed. The status of each indicator, whether occupied or not, and the usage of each marker as a brake or stop marker for a certain direction are displayed here, too.

If the digital system, to which these indicators belong, is running in offline mode, then you can toggle the state of each indicator by clicking on it with the mouse. In this way the movements of trains can be simulated very conveniently: simply select the block that
you want to look at on the computer screen and click on the occupancy, brake or stop indicator to simulate what happens if a train passes this indicator. Please refer also to chapter 9, “The Simulator”, for further details about simulation.
7 The Inspector

The Inspector helps you to have an overview of the objects of your model railroad - this is especially very useful in the case of large layouts with many turnouts, signals, routes, engines, trains, blocks, schedules, etc. The Inspector clearly displays the properties of the currently selected object. The references to other objects (for example turnouts in routes or blocks in schedules, etc.) are visible, too. With a click it is possible to skip to other referenced objects, to view their properties. Important attributes like the name or digital address of objects can be edited directly in the Inspector without the need to go through separate dialog boxes.

Diagram 107: Inspector
8 The Message Window

With the *Message Window* you can keep yourself up to date about the events occurring in *TrainController™ Bronze* while operating your model railroad with the computer. In certain situations *TrainController™ Bronze* displays informative, warning or error messages in the *Message Window*.

Most of these messages are generated by the *Dispatcher* (see chapter 5, “The Visual Dispatcher”). A special mode enables displaying of additional informative messages, which are useful to search for errors during creation of your automatic control system with the *Dispatcher*.

The different types of messages are marked with different symbols.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="symbol.png" alt="Informational message" /></td>
<td>Informational message. This type of message is often displayed, when a certain operation has been completed successfully.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Warning" /></td>
<td>Warning. The related action is performed, but certain problems may occur.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Error" /></td>
<td>Error. The execution of the related action is aborted.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Question" /></td>
<td>Question. Recommendation to check, whether a certain setting is intended or not.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Fatal error" /></td>
<td>Fatal error. This message is for example displayed, when an object needed to perform the current action, has been deleted by the user. Normally a user intervention is necessary, to correct the data.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Planned wait" /></td>
<td>Planned wait.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="An engine or train is ready to be controlled manually." /></td>
<td>An engine or train is ready to be controlled manually.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Detail message. Messages of these type can be optionally displayed to ease the search for errors when the control system is created." /></td>
<td>Detail message. Messages of these type can be optionally displayed to ease the search for errors when the control system is created.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Additional information." /></td>
<td>Additional information.</td>
</tr>
</tbody>
</table>

It is also possible, to copy the text of messages to the clipboard or to save it to a text file.
Dr. Railroad

Dr. Railroad is another outstanding feature of TrainController™ Bronze. This function checks all data entered into TrainController™ Bronze with artificial intelligence and detects automatically logical and other failures, lists them in the message window and gives hints to correct them.
9 The Simulator

With TrainController™ Bronze it is possible to simulate the operation of a model railroad automatically and without human intervention.

The traffic control (see chapter 6, “The Traffic Control”) allows you to simulate the movement of running trains by triggering of the contact indicators, that belong to the particular blocks. Simulated triggering of the contact indicators is accomplished by clicking on the particular indicators with the mouse.

The simulator window can run such simulation automatically without the need for manual clicks on indicators. To start the simulation open the simulator window via the Window menu and press the Start button in the simulator window.

![Diagram 108: The Simulator Window](image)

The following prerequisites must be fulfilled to run the simulation:

- The software must run in offline mode, i.e. the computer must not be connected to a digital system.
- The software must run outside edit mode.

The simulator solely simulates the triggering of indicators by running trains. It does not operate anything. In particular it does not affect the speed or direction of running trains directly nor does it start or stop any trains. The speed of trains is set by the usual means – e.g. by running schedules or by using the controls of the train window. For running trains, however, the simulator is able to calculate, which contact indicator will be triggered next and when. These calculations are based on the current position of each running train and the path, which it is about to take. Note, that only those contact indicators are simulated, that are directly assigned to a block (see section 5.6, „Blocks and Indicators“).
10 A Sample Layout

General

The layout displayed below will be operated with TrainController™ Bronze:

![Diagram 109: Sample Layout](image)

The layout has two stations: “Souhtown” located on the left side of the layout and “Northville” located at the end of the branch line. There is an additional hidden yard that is covered by the mountain.

This can be seen better in the track plan displayed below:
The main line, i.e. the loop that connects “Hidden Yard” and “Southtown”, will be operated automatically under full control of the Dispatcher. The branch line from “Southtown” to “Northville” will be operated manually.

In the following the necessary steps to control this layout are explained. TrainController™ Bronze is installed with a set of sample files called STEP1.YRR to STEP5.YRR. Each of these files corresponds to the content of one of the following sections. By loading these files into TrainController™ Bronze you can reconstruct for yourself, how the particular steps are performed.

**Step 1: Creating the Switchboard**

The first steps are creation and drawing of the switchboard.
Diagram 111 shows the switchboard of the sample layout. All turnouts get appropriate names. The related digital addresses are assigned, too.

At this stage we are able to control all turnouts on our sample layout.

**Step 2: Defining the Engines**

Our switchboard is now completed and we are going to create the entries for the engines that we want to run on the layout. We want to run three trains, a passenger and a freight train that can run on the main line only, and an additional train that can also go to Northville. The trains are entered into the Train Window as displayed below:
By editing the properties of each engine we assign a digital address to each engine and can additionally specify engine functions, measure the threshold speed and the speed profile and edit other properties. This is not outlined in detail here, because it is not important for understanding of this sample layout. Further details can be found in chapter 3, “Train Control”.

The images have been prepared with TrainAnimator™.

Through the Window menu of the software you can open additional Train Windows, if you want to control each train through a separate Train Window.

At this stage of the sample we are able to control our trains manually with the computer on all parts of the sample layout.
Step 3: Creating Blocks

At first we divide our layout into logical blocks. We follow the guidelines on page 100. The resulting block structure looks as follows:

![Diagram 113: Block structure of the sample layout](image)

Each blue track section represents a separate block.

Based on this diagram we insert a block symbol for each block into the switchboard. The resulting switchboard is displayed in the next diagram:
Based on this switchboard the *Visual Dispatcher* automatically calculates the following block diagram:
Please note that the block diagram represents the track layout in rough outline. The actual track connection between “Main Line West” and “Hidden Yard 3”, for example, contains two turnouts. These turnouts are not drawn in the block diagram in detail. Instead a route between both blocks is created.

All necessary routes between all blocks are created and recorded automatically.

**Step 4: Contact Indicators**

We want to equip each block on the main loop with three occupancy sensors. The arrangement of indicators of each block follows Diagram 90 (please refer to page 118). The occupancy sensor in the center of each block (dark red zones in Diagram 116) will be used as brake indicator for both directions; the sensors on both sides of each block will be used as stop indicator for the related direction (light red zones in Diagram 116).

The branch line to “Northville” contains 3 blocks. Since we do not want to run automatic trains there it is sufficient to install one occupancy sensor in each of these blocks for train tracking of manual trains.
The grey tracks in Diagram 116 are not contained in any block. They are part of routes, which are assumed to be located between the blocks.
Indicators are created for each block according to the following table:

<table>
<thead>
<tr>
<th>Block</th>
<th>Indicator</th>
<th>Markers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hidden Yard 1</td>
<td>Hidden Yard 1</td>
<td>![image]</td>
</tr>
<tr>
<td></td>
<td>Hidden Yard East 1</td>
<td>![image]</td>
</tr>
<tr>
<td></td>
<td>Hidden Yard West 1</td>
<td>![image]</td>
</tr>
<tr>
<td>Hidden Yard 2</td>
<td>Hidden Yard 2</td>
<td>![image]</td>
</tr>
<tr>
<td></td>
<td>Hidden Yard East 2</td>
<td>![image]</td>
</tr>
<tr>
<td></td>
<td>Hidden Yard West 2</td>
<td>![image]</td>
</tr>
<tr>
<td>Hidden Yard 3</td>
<td>Hidden Yard 3</td>
<td>![image]</td>
</tr>
<tr>
<td></td>
<td>Hidden Yard East 3</td>
<td>![image]</td>
</tr>
<tr>
<td></td>
<td>Hidden Yard West 3</td>
<td>![image]</td>
</tr>
<tr>
<td>Main Line East</td>
<td>Main Line East</td>
<td>![image]</td>
</tr>
<tr>
<td></td>
<td>Hidden Yard East Entry</td>
<td>![image]</td>
</tr>
<tr>
<td></td>
<td>Southtown East Entry</td>
<td>![image]</td>
</tr>
<tr>
<td>Main Line West</td>
<td>Main Line West</td>
<td>![image]</td>
</tr>
<tr>
<td></td>
<td>Hidden Yard West Entry</td>
<td>![image]</td>
</tr>
<tr>
<td></td>
<td>Southtown West Entry</td>
<td>![image]</td>
</tr>
<tr>
<td>Southtown 1</td>
<td>Southtown 1</td>
<td>![image]</td>
</tr>
<tr>
<td></td>
<td>Southtown East 1</td>
<td>![image]</td>
</tr>
<tr>
<td></td>
<td>Southtown West 1</td>
<td>![image]</td>
</tr>
<tr>
<td>Southtown 2</td>
<td>Southtown 2</td>
<td>![image]</td>
</tr>
<tr>
<td></td>
<td>Southtown East 2</td>
<td>![image]</td>
</tr>
<tr>
<td></td>
<td>Southtown West 2</td>
<td>![image]</td>
</tr>
<tr>
<td>Northville 1</td>
<td>Northville 1</td>
<td>![image]</td>
</tr>
<tr>
<td>Northville 2</td>
<td>Northville 2</td>
<td>![image]</td>
</tr>
<tr>
<td>Branch Line</td>
<td>Branch Line</td>
<td>![image]</td>
</tr>
</tbody>
</table>

Table 4: Indicator Configuration

The small icons indicate in which direction of travel a certain indicator is effective as brake or stop marker. The indicator “Hidden Yard 1”, for instance, marked by ![image] is used as brake marker of block “Hidden Yard 1” for both directions of travel. The indicator “Southtown East Entry”, marked by ![image] is used as stop indicator of block “Main Line
East” for trains that pass this block from the top to the bottom of the layout, i.e. from the Hidden Yard to Southtown. For trains running to the opposite direction this indicator reports that the train enters the block.

**Step 5: Creating Schedules**

One single schedule is sufficient to describe all train movements on the main line of the sample layout:

![Diagram 117: Schedule Diagram of the Sample Layout](image)

The blocks in “Hidden Yard” are marked as start blocks of the schedule. Since the schedule forms a closed loop these blocks are automatically calculated as destination blocks, too. The schedule can be started to both directions, i.e. trains can run clockwise or counter-clockwise under control of this schedule. Depending on a specific setting of this schedule, it allows either for train movements that start in Hidden Yard or for train movements that start in any other block of the main loop. All train movements will end in “Hidden Yard”, though.
Manual Operation

The branch line from “Southtown” to “Northville” and back will be operated manually. All precautions for train tracking have been already done by integrating the blocks of the branch line into the main block diagram accordingly.

Trains waiting in “Southtown” and bound to “Northville” will release block “Southtown 2” as soon as they leave “Southtown”. They will be automatically tracked to “Northville” and back. All is done by proper drawing of the main block diagram, no further actions are needed. A train that comes from “Northtown” and arrives in “Southtown” will automatically reserve block “Southtown 2” again.

From there it can be started by the schedule shown in the previous section and automatically travel to the “Hidden Yard”.

11 Special Applications

11.1 Extended Route Operation

Route Symbols in the Switchboard
In cases, where the Dispatcher is not being used, but it is desired to operate routes manually via a switchboard it is also possible to create routes in switchboards. Such routes are used to operate and lock the tracks and turnouts, that belong to the route. Routes are operated in the switchboard like on-off switches. If the route is turned on, then all turnouts of the route are operated. All track elements along the path of the route remain locked in this position until the route element is turned off again. As long as these elements are locked, they cannot be operated or used by other routes.

Manual Routes vs. Automatic Routes

TrainController™ Bronze distinguishes between manual routes and automatic routes. Automatic routes can be operated automatically by the Visual Dispatcher. Manual routes can only be operated through their route control. They cannot be operated automatically by the Visual Dispatcher.

A manual route is created by inserting a route symbol into a switchboard at an arbitrary location. The location of the route symbol in a switchboard does not matter. Especially the location of the route symbol must not relate to the location of the tracks and turnouts contained in this route. Manual routes are created, if the Visual Dispatcher is not being used at all or for those areas of your layout, which are only controlled manually with switchboards but not with the Visual Dispatcher.

An automatic route is always created as part of the block diagram of the Visual Dispatcher (for more details see section 5.2, “Blocks and Routes”).

With the exception, that manual routes cannot be operated automatically by the Visual Dispatcher, there are no further differences between manual and automatic routes.
Recording of Routes

All routes, that are not created by the automatic block diagram calculation in the dispatcher (see section 5.2, “Blocks and Routes”), require recording of the path of the route. This is done by selecting the route and using the Properties command of the Edit menu. In the following dialog, select the tab labeled Route and then press the button labeled Record.

This procedure starts the switchboard recorder and the path of the route can be recorded. The running switchboard recorder shows the small control panel displayed below:

![Diagram 118: The control panel of the switchboard recorder](image)

The control panel contains four buttons with the following meaning (from left to right):

- **Break**: Recording is interrupted and no elements are recorded until this button is pressed once more
- **Stop with Save**: Recording is terminated and the recorded elements are stored.
- **Cancel**: Recording is terminated and the recorded elements are not stored.
- **Help**: Display help information about the recorder.

After starting the switchboard recorder, you are able to record the route. First select the switchboard in which the intended path of the route is located. Then, click on the track where the route will begin. Finally, click on the track element, where the route will end. TrainController™ Bronze displays the tracks along the route as if the route were activated, but only if it is possible to reach the destination track from the starting track.

![Diagram 119: Active route with turnout and signal](image)

If you specify the start and end of a route in this way, then TrainController™ Bronze tries to find an arbitrary suitable path. Alternatively, you can also specify a path from the start to the destination of the route. To do this, move the mouse to the starting track. Press and hold the left mouse button and drag the mouse along the desired path to the
destination of the route. After reaching the destination release the left mouse button. Again TrainController™ Bronze indicates the tracks along the route as if the route were activated.

To extend an existing route, additionally press and hold the Shift key during the procedure outlined above.

Note, that routes, which are generated automatically by the block diagram calculation in the dispatcher (see section 5.2, “Blocks and Routes”) do not require any manual recording. The paths of these routes are automatically recorded during calculation of the block diagram.

### 11.2 Connecting a Second Digital System for Feedback Control

With TrainController™ Bronze it is possible to operate a second digital system in parallel to the first for monitoring of feedback sensors. This is useful, if

- Your favorite digital system does not support monitoring of track sensors and feedback events.
- Your digital system is too slow for efficient monitoring of track sensors – especially in the case of larger model railroad layouts.
- You want to use separate digital systems for operation and feedback monitoring.

During operation it does not matter, to which system particular feedback symbols are connected. TrainController™ Bronze handles all connected digital systems like one large system. All features can be used without any conditions as if only one large system were connected. It is for example not important if the indicators contained in a certain block are connected to the same digital system or to different systems. Only when the digital address of a track sensor is specified, then you have to take care, that the correct digital system is selected.
Index

accessories 76
accessory element 77
address, digital
  of accessories 77
  of engines 83
  of signals 77
  of turnouts 73
advance signal 125
automatic Operation 96
automatic route 166
AutoTrain 141

bitmap
  in the switchboard 78
block 100
  and indicators 113, 114
  brake marker 114
  braking ramp 116
  current block 108
locking a block 110
locking the exit of a block 110
occupied block 108
release in a schedule 137
reservation in a schedule 135
reserved block 108
states 107
  stop marker 114
block diagram 102
  calculated 102
block editor 113
block signal 124
  advance signal 125
  integrated 126
  signal aspect 124
block symbol 102, 111
brake marker 114

braking ramp 116
bridge 73

bump 73

calculated block diagram 102
commands
  properties of accessories 77
  properties of engines 83
  properties of routes 167
  properties of signals 77
  properties of turnouts 74
contact
  momentary 92
  occupancy sensor 92
contact indicator 92
  momentary contact 92
  occupancy sensor 92
crossing 73
current block 108
curve 73
cyclic schedule 140
destination block of a schedule 130
diagram
  block diagram 102
digital address
  of accessories 77
  of engines 83
  of signals 77
  of turnouts 73
digital system 50
direction of travel 106
dispatcher 102, 147
Dispatcher 96
dispatcher window 102, 147
display of train positions 79
distance, simulated 87
double slip turnout 73
  solenoids 75
Dr. Railroad 153
driving mode, of a schedule 140

edit mode 64
engine 83
digital address 83
  orientation 106
engine function 89
entry lock, of a block 110

feedback indicator 92
file
  layout file 64
four aspect signal 77
function
  engine function 89

hidden yard 144

image 78
image element 78
indicator
  and blocks 113
  contact indicator 92
  feedback indicator 92
Inspector 151
integrated block signal 126

label
  in the control panel 77
layout file 64
light 77
locking block exit 110
locking of blocks 110

manual route 166
marker
  shifted stop marker 122
maximum scale speed 86
menus

Edit 167
  Edit, Switchboard 74, 77
  Edit, train window 83
message window 152
mode, driving mode of a schedule 140
momentary track contact 92

occupancy sensor 92
occupied block 108
odometer 87
offline mode 51
on-off switch 77
optical sensor 92
orientation
  of an engine 106

path selection in schedules 136
position
  display of train positions 79
push button 77

ramp
  braking ramp 116
reed contact 92
release of blocks and routes in a
  schedule 137
reservation of blocks and routes in a
  schedule 135
reserved block 108
reversing loop 109
route 166
  automatic route 166
  between blocks 105
  manual route 166
  release in a schedule 137
  reservation in a schedule 135

scale speed 87
scale speed, maximum 86
schedule 128
  cycle 140
  driving mode 140
path selection 136
release of blocks and routes 137
reservation of blocks and routes 135
start and destination block 130
successor 144
schedule diagram 128
schedule selection 146
selection
of a schedule 146
sensor
momentary track contact 92
occupancy sensor 92
shifted stop marker 122
shuttle train 140
signal 76
integrated 126
Signal 77
signal aspect
block signal 124
simulated distance 87
simulator 154
single slip turnout 73
slip turnout 73
sound files
engine function 89
speed profile 87
speed, scale 87
speedometer 87
start block of a schedule 130
stop marker 114
shifted stop marker 122
straight 73
style of user interface 61
successor of a schedule 144
switchboard recorder 167
text element 77
text label 77
three aspect signal 77
three way turnout 73
threshold speed 87
throttle 85
toggle switch 77
track contact 92
track elements 73
track occupancy sensor 92
Traffic Control 149
Train List 82
train position
display 79
train tracking 110, 111
train window 80
turnout 73
two aspect signal 77
uncoupler 77
user interface
style 61
waiting time 138
window
dispatcher window 102, 147